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Contact Information 

Visit the Contact OLI Systems page at https://www.olisystems.com/contact to submit general 
inquiries, contact Technical Support, or search for an address and phone number. 

 

If you need to contact Support, an online request form is located at the OLI Systems Tech Support 
page at https://www.olisystems.com/contact-tech-support. Other useful links and resources are:  

• OLI Systems Support Email: oli.support@olisystems.com  
• Product Downloads: http://downloads.olisystems.com/  
• OLI Systems YouTube Channel: https://www.youtube.com/OLISystems 
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Disclaimer 

This manual was produced using the OLI Studio / OLI Analyzer 10.1 build 1 (10.1.1). As time 
progresses, new data and refinements to existing data sets can result in values that you obtain 
being slightly different than what is presented in this manual. This is a natural progress and cannot 
be avoided. When large systematic changes to the software occur, this manual will be updated. 
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 – Introduction to OLI 
Studio: ScaleChem  

About This Manual 

This manual uses OLI Studio: ScaleChem to model real world scaling situations while learning 
scaling theory and science, and the reasoning for making certain decisions with the software. 
Explanations of theory, science, software decisions, and ScaleChem features appear in plain text. 
Checkmarks (✓) accompany systematic tasks. Sidebars and remarks are shaded.  

In Chapters 2-5, we model a hypothetical field and learn about basic ScaleChem tools. We model 
a new field in Chapter 6 then combine the two fields together in Chapter 7. Chapters 8-11 use real 
world field examples. Chapters 20 discusses Alkalinity calculations. 

If you have not yet installed the software, please install it following the instructions given in 
Installation and Security page in our Wikipage at: 
http://wiki.olisystems.com/wiki/Installation_and_security. 

 

OLI Studio Components 

The OLI Studio is a software suite containing several modules including, Stream Analyzer, 
ScaleChem and Corrosion Analyzer. A client’s license determines which modules are enabled 
within the OLI Studio Software. 

 

Stream Analyzer 

Stream Analyzer is standalone software, and it is the main interface of the OLI Studio. Stream 
Analyzer is a comprehensive thermodynamic tool that calculates speciation, phase equilibria, 
enthalpies, heat capacities and densities in mixed-solvent, multicomponent systems. Capabilities 
and features of Stream Analyzer are: 

• Three different thermodynamic frameworks:  

o Aqueous (AQ) model 

o Mixed Solvent Electrolyte (MSE) model  

o Mixed Solvent Electrolyte and Soave-Redlich-Kwong (MSE-SRK) model 

 

http://wiki.olisystems.com/wiki/Installation_and_security
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• Thermophysical properties: Stream Analyzer has thermophysical models to predict surface 
tension, interfacial tension, viscosity, electrical conductivity, thermal conductivity, diffusivity, and 
osmotic pressure. 

• Molecular and ionic inflows: Stream Analyzer accepts molecular inflows, typical of a process 

stream, and ion inflows, typical of a sample water analysis. 

 

ScaleChem 

ScaleChem is a simulation software tool that predicts scaling problems during oil and gas 
production. ScaleChem simulates fluid production from the reservoir to the sales point, and 
computes the phase mass balance, scale tendencies, and scale mass of production fluid at each 
location in the production line. Capabilities and features of ScaleChem are: 

• Brine, gas and oil analysis 

• Scaling scenarios 

• Compatibility testing of brines using the stream mixing function 

• Phase equilibrium calculation used to perform four-phase reservoir saturation, from which as 

whole fluid reservoir composition is determined 

• Contour plots to study produced brine properties across a broad temperature and pressure range 

 

Corrosion Analyzer 

Corrosion Analyzer is a module within the OLI Studio. A separate license enables this module. 
Corrosion Analyzer is first-principles corrosion prediction tool. It is used to predict the corrosion 
rates of general corrosion, propensity of alloys to undergo localized corrosion, depletion profiles of 
heat-treated alloys, and thermodynamic stability of metals and alloys. It enables users to address 
the causes of aqueous corrosion by identifying its mechanistic reasons. As a result, users take 
informed action on how to mitigate or eliminate this risk. 

Corrosion Analyzer calculates corrosion by quantifying the bulk chemistry, transport phenomena, 
and surface reactions through a thermophysical and electrochemical module. 

The thermophysical module calculates the aqueous solution speciation and obtains concentrations, 
activities and transport properties of the reacting species.  

• The electrochemical module simulates partial oxidation and reduction process on the metal 

surface.  

 

The tool reproduces the active-to-passive transition and the effects of solution species on passivity. 

Effects of temperatures, pressure, pH, concentration, and velocity on corrosion are also included. 
Capabilities and features of Corrosion Analyzer are: 

• Generation of Pourbaix (E vs pH) diagrams 

• Calculation of general corrosion rates  

• Localized corrosion susceptibility 

• Heat treatment effect 

• Generation of polarization curves plots 
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What is OLI Studio: ScaleChem? 

OLI Systems, Inc. is an electrolyte-thermodynamics research company. The OLI Studio is its flagship 
software suite. When we open the OLI Studio, a splash screen indicates the available subsets or 
modules that our license enables. These subsets include Stream Analyzer, Corrosion Analyzer, and 
Studio ScaleChem. The modules all share a common interface.  

 

 

 

We use the phrase Studio ScaleChem (SSC) to distinguish it from the original ScaleChem or 
ScaleChem Standard. ScaleChem Standard predicted the four-phase chemistry of produced fluids. 
The software covered the chemistry specific to oil and gas production and their respective mineral 
phases. In 2012-2013, OLI product developers incorporated ScaleChem technology into the OLI 
Studio.  

 

The Shell Oil Company originally developed the technique to predict high temperature and pressure 
effects on brines. In the 1980s, OLI linked this technique to its own predictive aqueous model. In the 
1990s, OLI replaced this model with a rigorous temperature and pressure model, the Helgeson-
Kirkham-Flowers Equation of State. OLI refit all accepted mineral scaling experimental data to the 
new model. The model has been the industry mainstay ever since and is considered the standard 
for such calculations.  

 

Why Use Studio ScaleChem? 

Scale problems arise when fluid, initially in equilibrium with its environment, is disturbed and 
becomes unstable. The unstable fluid results in H2O, CO2, and H2S partitioning across the water, 
oil, and gas phases, corrosion of metal surfaces, and precipitation/dissolution of solids. SSC 
recognizes all three effects, which are all important to the oil and gas production professional. 

Precipitates form when mineral-forming elements increase the concentration of produced waters 
beyond supersaturation, or the saturation point. The primary causes of supersaturation are 
pressure, temperature, phase partitioning, and fluid mixing. SSC quantifies the effects on mineral 
scale potential while calculating the physical and chemical properties of fluid and gas phases. 
Industry professionals can use the software’s calculations to help determine the best methods to 
deal with scaling situations. 
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General View of the OLI Studio User Interface 

In the OLI Studio Software, the OLI Studio Desktop User Interface provides the environment to 
create, analyze and interpret the results of your application chemistry. In this manual, an overview 
of the different windows and tools that you will be using within the software, as well as how to 
navigate the OLI Studio User Interface, will be provided here.  

The initial screen shows several panes or boxes, some of which we can minimize, pin, and move 
using the corner icons or by selecting View > Toolbars from the Menu Bar. Most of the screenshots 
used in this manual will not show the Object Library, Plot Template Manager, and Calculation 
Output Pane 

 

The screenshot shown above is what you will see when you first start OLI Studio. You can 
customize the desktop to your own needs. The windows can be resized, moved, docked and 
detached. 
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Panels Relevant to OLI Studio: ScaleChem 

The most important panes are described below. The training manual or instructor will provide 
further details about components of each pane. More information is also available by selecting 
Help > Help Topics from the menu bar, or by contacting OLI technical support.  

 

Navigator  

This pane contains the icons and names of each action in a hierarchical tree. This pane displays 
active Analyses (Brine, Gas, and Oil) and Calculation (Scale Scenario, Saturators, etc.) objects. OLI 
refers to Analysis and Calculation objects as Streams, which we “add” to the Navigator.  

 

 

Navigator View with SSC objects 

Filename A star next to a filename indicates that the file has 
been modified but not yet saved 

Global Streams Level Provides the broadest view of objects 
in the Navigator 

Stream Level Where we enter chemistry  

Calculation Level After completing calculations, the 
software automatically adds daughter or sub-streams. We 
can view sub-streams by clicking the “+” sign to the left of the 
parent stream, as shown below 

 

Actions  

The Actions Pane shows all objects that we can add to the Navigator. The objects shown in this pane 
are available depending on a client’s license.  

 

 

Actions Pane (shown in large icon view with widened window) 

 

The Actions pane is contextual and changes depending on the selected stream. We can add objects 
by double-clicking the Actions Pane icon or through the Menu bar using Streams > ScaleChem or 
Calculations > ScaleChem.  
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Add objects by selecting the icon in the Actions pane or through the Menu bar  

Description  

This pane contains the Design, Report, Description and other tabs. This pane changes depending 
on the active object. When we add any SSC object, the screen automatically switches to the Design 
tab, which is unique for each object. Each Design tab has a set of colored vertical tabs with data 
entry screens. Most objects also have a Summary box and certain Calculation objects display a Plot 
tab.  

       

Description Panes of ScaleChem objects. 

 Brine Analysis (left), Scale Scenario (middle), and Gas Analysis (right). 
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 – Olympus Brine 
Analysis & Scale Scenario  

Overview  

This chapter focuses on two ScaleChem objects, Brine Analysis and Scale Scenario. You will input 
a water analysis and its measured properties into a Brine Analysis object. This is Task 1. You will 
then test the brine properties in a Scale Scenario object to compute if the mineral scales will 
precipitate as the fluid flows up the well. This is Task 2. 

 

Setting up the Work File 

✓ Launch the software  

 

✓ Select File > Save As… from the menu bar 

✓ Type SSC Basics or another title in the File name field, then click Save  

 

 

  

A typical OLI Studio software installation creates a folder within a PC’s Document directory called 
“My OLI Cases.” By default, OLI Studio cases (files that end with the *.oad extension) are stored 
in this folder.  
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Task 0 – Set Thermodynamic Framework to MSESRK 

Before starting the calculations, you will change some settings.   

✓ Click on the Streams object in the Navigator Panel 

 

 

✓ Change the name from Streams to ScaleChem Training by double clicking on it or changing 
the name directly in the Description tab 

 

 

✓ Select Chemistry>Model Options from the Menu 

 

 

✓ Change the Thermodynamic Framework to MSE-SRK (H3O+ ion)  
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Task 1 – Create a New Brine Analysis  

Your first action is to create the brine analysis object. You will use the data in the table given 

below.  

✓ Add a Brine Analysis from the Actions panel by double clicking on it.  Or select the Brine 
Analysis from the menu (Streams > ScaleChem > Add Brine)  

   

 

 Right click on the Actions Panel to display the objects in the List format 

 

 

The Brine Analysis opens to the Design tab and the Data Entry grid. Before inputting the brine’s 
composition, you will perform a few formatting changes to make your work go smoother. 

✓ Select the Description tab  

✓ Change the brine name to Olympus 1 Brine  

 

 You can also highlight the icon in the Navigator and select the <F2> key to change object names. 
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✓ Select the Design tab 

✓ Click on the Display dropdown button and select Formula 

 

✓ Enter the concentrations from the table below 

Table 1: Olympus 1 Brine Analysis 

Cations mg/L Anions mg/L Neutrals mg/L Measured Properties 

Na+1 36000 Cl-1 57000 SiO2 15 Temperature 25 ⁰C 

K+1 300 SO4-2 250   Pressure 1 atm 

Ca+2 600 HCO3-1 600   pH 7.67 

Mg+2 150     Alkalinity --- 

Sr+2 80     Density (g/ml) 1.064 

Ba+2 5     Total Dissolved Solids (mg/l) 96280 

✓ Make sure to select the Dominant Ion balance option type 

The software balances charges according to the selected option and displays this in the yellow 
column. Notice in the Data Entry grid’s Balanced Column (yellow column) that the Na+ concentration 
is 36,116 mg/l.  

✓ Review the Summary panel.  The Dominant Ion Charge Balance is summarized there.  

 

 

The Summary box shows additional detail about the brine. The Stream Parameters table shows 
default values. The Dominant Ion Charge Balance shows the cations and anions equivalents and 
the charge imbalance. The charge imbalance is -0.005 eq and the software added 116 mg/L of Na+1.   
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The four available Balance Options are explained below.  

 

The next step is to enter measured properties and calculate the brine properties.  This is done in the 
Reconcile tab.  

✓ Select the Reconcile (blue vertical) tab 

✓ Enter the measured pH (7.67), Density (1.064 g/ml), and TDS (96280 mg/L) 

 

 

The next step is to calculate the brine properties. There are five calculation, or Reconciliation, options 
that are described below. 

 

Dominant Ion. The dominant ion of the deficient charge is 
added. The dominant ion is based on moles/kg 
concentrations. 
 

 

Prorate Cation. The complete set of cations is prorated 
(all concentrations are multiplied by the same ratio). 
 

Prorate Anion. The complete set of anions is prorated. 
 

Makeup Ion. The user selects an ion. Its concentration is 
then increased or decreased depending on the charge 
requirements. 
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You will use the default Concentration Data Only option for this case. 

✓ Select the Calculate button or press the <F9> key  

 

 We can also see a more detailed view of the calculation’s progress, along with non-convergence 
messages, in the Calculation Output pane (if active) at the bottom of the screen.  

 

The calculated pH and alkalinity differ slightly from the measured values. It is possible to adjust these 
using the Measured pH and Alkalinity option, but it is not part of this example. Three additional 
properties, density, conductivity, and TDS are shown in this grid. 

1. Concentration Data Only. This approach uses ion concentration data only. The pH is 
computed from the concentration of weak acid and base ions (e.g., HCO3

-1, CO3
-2, HS-1, 

Acetate-1, and Fe+2), and of acids and bases (e.g., CO2, H2S, H3BO3, Acetic acid, even HCl).  
This is the default option. 

 

2. Gas-Phase CO2 Content (mole%). This option uses the concentration data described 
above plus the CO2 partial pressure. For instance, air contains 400 ppmV (0.04 mol%) CO2. 
This 0.04 mole % is entered in the CO2 fraction field, the pressure is set to 1 bar, and the 
software computes the properties of a brine that is in contact with air. Similarly, the software 
can compute the brine in a separator if that CO2 and pressure are entered. 

 

3. Measured pH and Alkalinity. This option uses the entered concentration data, plus the 
measured pH and alkalinity. This option is useful when reliable lab/field pH and alkalinity 
values are available. The alkalinity is the Total Alkalinity, representing all proton-accepting 
species down to 4.5 pH. The software adjusts the HCl and CO2 amounts until the calculated 
pH and alkalinity match the measured values.  

 

4. Measured pH Only. This option uses the entered concentration data and the measured 
pH. This option is useful when reliable lab/field pH values are available. The software 
adjusts the HCl amount until the calculated pH matches the measured value.  

 

5. Measured pH, Alkalinity and TIC. This option uses the concentration data, plus the 
measured pH, alkalinity and Total Inorganic Carbon (TIC). This option is useful when there 
is a clear distinction between the organic and inorganic carbon contribution to alkalinity. 
The alkalinity is the Total Alkalinity, representing all proton-accepting species down to 4.5 
pH. The software adjusts the HCl, Acetic Acid, and CO2 amounts until the calculated pH, 
alkalinity and TIC match the measured values.  
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 Notice that the Total Dissolved Solids (TDS) were not calculated. This is because the by default 
the TDS calculation is turned OFF. If you want to see the calculated value, go to the Calculation 

Options icon  or right click on the Olympus 1 Brine and select Calculation Options. Then re-
run the case to see the calculated TDS value. 

 

 

The complete set of results are in the Report tab.  

✓ Select the Report tab   

 

✓ Review the Phase Properties table 

     

The pH and alkalinity are reported here, along with additional properties of this 1-liter brine sample.    
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✓ View the Pre and Post Scaling Tendencies table next 

 

Olympus 1 Scaling Tendencies with Solids Off  

 

The software computes that BaSO4, CaCO3, and SrCO3 are supersaturated (S>1) in this sample 
(see Pre-scaling values). The remaining minerals are sub-saturated (S<1). No solids form because 
the Brine Analysis object has solids-formation turned off by default.  

 

✓ Scroll down to the Brine Composition table.  

 

Olympus 1 Brine Composition with Solids Off 

 

This table contains the dissolved species concentration in the brine. It will be identical to what is 
added, because the brine is a single-phase.  If solids were allowed to precipitate in the calculation, 
then the concentrations would have deviate from the initial values.  

What are scaling tendencies?  

• The Scale Mineral column lists species with pre-scale tendencies of at least 110-4.  

• The Pre-scaling column is the thermodynamic driving force for precipitation. It 
represents the conditions at time=0, meaning conditions before any precipitation can 
commence. This value is based on the following relationship (shown for CaCO3): 

𝑆𝐶𝑎𝐶𝑂3 =
𝑎
𝐶𝑎+2

𝑎
𝐶𝑂3

−2

𝐾𝑠𝑝𝐶𝑎𝐶𝑂3
.  

• The Pre-Index column is the base-10 logarithm of the pre-scaling tendency.  

• The Post-Scaling and Post-Index columns are the scaling tendency values after the 

precipitation process is complete. It represents conditions at time=, when solids 
reach equilibrium with the water.  

If we allowed solids to form, the table would also have a Max scale column showing solid 
concentration, per liter of brine, if the brine reached equilibrium.  
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Task 2 – Create a New Scale Scenario Calculation 

The next task is to calculate the scaling potential during production. This is done using the Scale 
Scenario object. The software computes the tendencies and mass for each mineral at each location 
created.  Results are presented in plots. 

✓ Select Calculations > ScaleChem > Add Scenario from the menu, or double-click on the Add 
Scale Scenario icon in the Actions pane 

     

 

The software adds a Scale Scenario object to the navigation panel and opens to the Design screen.   

 

There are three vertical tabs: Inlets, Conditions, and Solid. You will work in each section to set up 
the calculation.  

 

Initial Design screen of a newly added Scale Scenario object 

 

✓ Rename the object Olympus 1 Production (select the Description tab or press the <F2>) 

 

✓ Select the Design screen then the Inlets tab  

✓ Click on the cell in the Type column to activate a dropdown list.  Select Brine (m3/day) 

The focus will automatically switch to the Name column. 

✓ Select the Olympus 1 Brine from the dropdown menu in the Name column  
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✓ Enter 200 (m3/day) in the Flow column  

  

 

 When an inlet row is active, the Detail Info of the grid at the bottom of the Inlets screen displays 
the composition of the inlet we selected. In our case, this is the Olympus 1 Brine composition. 

  

 

✓ Select the Conditions tab (vertical blue tab on the left side of the Design screen) 

 

The Conditions tab contains 4 columns: Location, Temperature, Pressure, and Drop Solids. 

 

✓ Type in the following conditions or use the dropdown menu within the Location cells 

 

Location Temp ( C) Press (bar) 

Reservoir 125 275 

Bottom hole  125 260 

Downhole 115 190 

Midwell 105 130 

Wellhead 100 100 

Choke 90 80 

Separator 60 30 
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The location cell contains a dropdown menu with commonly used locations, like reservoir, wellhead, 
separator etc.  You can use one of these names or type in a name.  A location name is required. 

 

 

A diagram appears below displaying the order of the locations that are entered. This screen has 
options for zooming, auto steps, sorting by temperature or pressure, and dropping solids.  

 

 

 

✓ Select the vertical (red) Solid tab and  

✓ Check the Standard box (to allow these solids to precipitate) 

 

✓ Press the Calculate button  
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✓ Select the Plot tab  

 

The default plot is the pre-Scale tendencies for the five dominant solids, including Calcite and 

Barite. Several minerals are computed to be supersaturated in the reservoir and at other 

production locations. 

✓ Select the View Data button  

 

The View Data button displays the results table. In some cases, this is an easier way to interpret the 
results.    

 

✓ Select the Variables button  
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✓ Remove all the variables in the Y1 Axis field by clicking on the Y1 Axis title bar then pressing 
the double left arrows. Or, double-click on the variable you want to remove 

  

✓ Open the Solid category and move CaCO3 and BaSO4 to the Y1 Axis by double-clicking the 
name  

 

✓ Next, expand Additional Stream Parameters and move pH - Aqueous to the Y2 Axis by using 
the double arrow >> next to the Y2 axis 

 

     

✓ Press OK and view the Data Table 
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✓ Select the View Plot button  

 

 

According to the calculation, significant amounts of calcite precipitate in the reservoir and the amount 
decreases at each subsequent calculation as temperature and pressure decreases. The values 
shown in the plot are the maximum amounts of solids that will form at that location. No assumption 
is made that these solids actually form at each location (this requires a fluid dynamic and deposition 
model).  Rather all scale mass moves with the fluid to the next calculation unless specified to deposit 
using the Drop Solids button in the Conditions tab. 

 

The calculated pH increases during production. This is for two reasons. The first is that as less calcite 
precipitates, more alkaline CO3

-2 remains in solution. The second is that lower temperatures causes 
the pH of a solution to be higher. 

✓ Save the file  

Summary 

The instructions provided in this chapter are the most basic ScaleChem calculation. It is a two-step 
process, adding a brine and calculating its scaling potential as the well is produced. You will see in 
the following chapters that adding additional details to this basic scenario can increase reliability to 
the predictions. 
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 – Olympus Gas 
Analysis  

Overview 

This chapter introduces the Gas Analysis object. It is a very simple object with a limited number of 
functions. It is designed in a way that a user can enter conveniently, their gas analysis. You will 
continue working within the created file in Chapter 2.  

 

Task 3 – Create a New Gas Analysis  

✓ Double-click on the Add Gas Analysis object in the Actions Panel 

 

This adds a Gas object to the Navigator panel. 

✓ Select the Description tab, then rename the object Olympus Gas  

 

✓ Select the Design tab 

The names view of the Gas Analysis is defaulted to Formula view. Also, the Standard list of 
components extends to C6 alkanes. This is satisfactory for the gas analysis you will enter. 

✓ Enter the following composition and values in the Inflows grid:  

Olympus 1 Gas  

Formula  Component Name mole %  Formula  Component Name mole % 

H2O Water 1.80 C3H8 Propane 8.00 

N2 Nitrogen 3.00 i-C4H10 Isobutane 1.00 

CO2 Carbon dioxide 1.50 n-C4H10 n-Butane 3.00 

H2S Hydrogen sulfide 0.50 i-C5H12 Isopentane 0.50 

CH4 Methane 65.5 n-C5H12 n-Pentane 0.70 

C2H6 Ethane 14.0 n-C6H14 n-Hexane 0.50 

The Inflows grid will look like one of the two below, depending on the Names view you select. 
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Olympus 1 Gas Inflows in Display Name View Olympus 1 Gas Inflows in Formula View 

 

This is the extent of the gas entry step. There are modifications that can be part of this step, but in 
this scenario, they are not considered.  Now that the gas is entered, the Olympus scale scenario will 
be recomputed. 

 

Task 4 – Recalculate the Scale Scenario with the Gas 

The gas analysis was missing from the Scale Scenario calculation performed in Chapter 2. The net 
effect was that calcite was computed to be supersaturated. This is because the impact of gas-phase 
on the brine composition was not considered. You will see that by including the gas phase, the calcite 
scale risk will change considerably. 

 

✓ Select the Olympus 1 Production icon in the Navigator pane 

 

✓ Select the Design tab (horizontal tab) if not automatically sent there 

✓ Select the Inlets tab (vertical) if not automatically sent there 

✓ Click the Type cell in the 2nd row and select Gas from the drop-down list 

  

✓ The Name cell should display automatically the available gases. There should be one only, 
Olympus 1 Gas, select it. 

 If the Olympus gas is not present in the drop-down cell, this is an indication that the Gas 

Analysis Object is using a thermodynamic model different from the Brine Analysis object.  Make 

certain that the Gas Analysis and Brine Analysis objects are both using the MSESRK (H3O+ ion) 

framework. 
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✓ Enter a flow rate of 250 std E3m3/day in the Flow cell 

  

✓ Calculate (Press the <F9> key) 

✓ Select the Plot tab  

 
The plot will be displaying the last set of variables that you added, Calcite solids and pH. You will 

change this back to the default plot variables, the Dominant Scale Tendencies.   

✓ Double-Click on the [Default Plot] item in the Plot Manager window. This is in the lower left of 
the screen 

 

This will cause the plot to return to the default variables (and settings).  

  

Pre-Scaling Tendencies Including Brine and Gas Analyses 

The plot differs from the one computed at the end of Chapter 2 (see below). This is because the gas-
phase CO2 introduces acid (carbonic acid) to the water. This causes the pH to decrease, which in 
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turn reduces the CO3
-2 ion concentration. This result is that the scaling tendencies for the three 

carbonate solids (Calcite, Aragonite, and Strontanite) decrease. 

 

Pre-Scaling Tendencies Including Only Brine Analysis 

 

✓ Change over to View Data  

 

The saturation of Calcite at reservoir conditions is now S≈0.6, or twenty-three-times lower than the 

S≈14.5 in Chapter 2. 

 

Notice that there is no longer any calcite scale, because it is now sub-saturated throughout the 

production line. The next step is to quantify the impact of the gas on the pH. 

✓ Open the Variables window 
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✓ Double-click on the Y1 Axis variables to remove it 

✓ Add pH to the Y1 axis (pH is in the Additional Stream Parameters category) 

  

✓ Click OK to close the window 

✓ Change to View Plot 

Notice that the pH range of this calculation is about 0.5 units below that of Chapter 2. This again, is 

caused by including the CO2-containing gas phase in the scale scenario. 

 

✓ Save the file   
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Summary 

A more representative scale scenario is achieved when the gas phase is included in the study. This 
is because brine production is in contact with the hydrocarbon phase, and by including it in the scale 
calculation, its impact on overall scale formation can be part of the scale risk analysis. 

 

Calcite is also computed to be sub-saturated in the reservoir. This may, or may not be the case, 
depending on the reservoir mineralogy/cementation. In the next chapter we will investigate the 
impact of setting the gas and brine phase in equilibrium with the reservoir minerals, and its effect on 
mineral scaling.  
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 – Olympus Reservoir 
Saturation 

Overview 

You will use the Saturator object to set the reservoir minerals at equilibrium with the produced fluid. 
It is reasonable, in some cases, to saturate the produced fluid with common evaporite and secondary 
minerals like CaCO3, CaSO4.H2O, FeCO3, and NaCl. This is based on the assumption that as the 
reservoir fluid flows through the rock pores, there is sufficient time to interact with the surface 
minerals and that this interaction occurs across the complete vertical production zone (the 
composition of the liquid flowing into the well does not vary with depth). The effect is that a single 
fluid composition flows into the well and this liquid+gas fluid is in equilibrium with the reservoir 
minerals. 

 

This particular Olympus well produces from calcite-cemented sandstone. Barite is also present in 
minor quantities in the rock matrix. It is reasonable therefore, to saturate the fluid with calcite at 
reservoir conditions. This will cause Ca+2 and CO3

-2 to be added to the fluid and this revised brine 
composition will now be different from what was entered in Chapter 2. Because there is a 
composition change, you will create a new fluid called Olympus 1 Reservoir. This is a gas+brine 
fluid combination that will be used instead of the brine and gas analysis entered in the previous 
chapters. 

 

To complete Chapter 4, you will need to have completed Chapters 2 and 3 first. 

 

Task 5 – Add a Saturator Calculation  

✓ Open the Course file you used to compete Chapter 2 and 3.   

 

This file should look like the following. 
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✓ Click on the Add Saturator icon from the Actions panel   

 

The Saturator appears in the Navigator panel.  

✓ Select the Description tag to rename the object Olympus 1 Reservoir 

 

✓ Select the Design tab 

 

 The Saturator has two vertical tabs, Inlets and Solid. Fluids are entered in the top grid and 
Conditions are entered in the bottom grid of the Inlets tab. Solids are selected and saturated in the 
Solid tab. 

 

✓ Use the pull-down menus to select the following Fluid types, names, and flow rates 

 

Olympus 1 Reservoir 

Type Name Flow 

Brine (m3day) Olympus 1 Brine 200 

Gas (std E3m3/day) Olympus Gas 250 

 

✓ Enter the Reservoir conditions of 125°C and 275 bar in the Conditions section 

  

 

 

✓ Select the Solid (blue) tab 
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Saturating the fluid with minerals is a two-step process. The first step is selecting in the upper 
section of the window (Solid Selection), and then selecting it to saturate in the lower section of 
the window (Reservoir Mineral Saturation Section). 

 

 

 

The upper section instructs the software to allow the selected solids to precipitate – to include 
the solid-liquid equilibrium equation in the calculation. It does not instruct the software to saturate 
these solids. Rather, if the phase is supersaturated, then it will precipitate. 

 

It is in the lower section that saturated solids are chosen. This section contains two columns. The 
first column (Mineral to saturate) where the saturating mineral is selected. The second column 
(Inflow to vary) is the cation and anion to be adjusted. The image below has barite and calcite 
as saturating solids, and Ba+2, SO4

-2, Ca+2, and CO3
-2 as being adjusted. 

 

 

 

For example, if barite is computed to be initially sub-saturated, then BaSO4, in the form of Ba+2 
and SO4

-2 ions are added in stoichiometric amounts until barite saturation is achieved.  
Stoichiometric amounts are required so the water maintains a charge balance. 

 

By comparison, if Calcite is computed to be initially supersaturated, then stoichiometric amounts 
of Ca+2 and CO3

-2 are removed from the fluid until calcite is at saturation. Thus, the inflows will 
be positive if the solid is sub-saturated and negative if the solid is supersaturated. 
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✓ Select the Standard checkbox  

 

 

At this point, you will notice that the Calculate button is yellow . This is because no 
minerals have been selected to saturate the fluid.  A warning also appears in the in the Summary 

box . A yellow button is allowable, and a calculation may continue; it is merely 
a warning that the case is incomplete. 

 

✓ In the Reservoir Mineral Saturation Section use the Solid drop-down menus to select BaSO4 
(Barite) and CaCO3 (Calcite) as Mineral to saturate 

 

✓ Use the Inflow drop-down menu to select BaSO4 and CaCO3 as Inflow to vary (it should have 
been selected automatically). 

 

 

 

The Inflow to vary list is lengthy because there are many ways of adding Ba+2, SO4-2, Ca+2, and 
CO3

-2. Deciding on which inflows to vary depends on the user’s assessment of the fluid composition 
and which concentration is the most appropriate to change. 

 

At this point, the Calculate button is green indicating that the specifications are complete.   

✓ Calculate (or press the <F9> key)  

✓ Click the Report tab   
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The Saturator Report tab contains several tables: Saturation Details, Inlet Summary, Stream/Phase 
Properties, Pre and Post Scaling Tendencies, Brine Composition, Gas Composition, and if selected 
an inlet summary.  

 

The key table is the Saturation Details. This contains the explicit Inflow changes. In this example, 
102.4 mg/L CaCO3 is added to the system (i.e. 41 mg/L Ca+2 and 61.4 mg/L CO3

-2).  Likewise, 1.5 
mg/L BaSO4 was added (i.e. 0.9 mg/L Ba+2 and 0.6 mg/L SO4

-2). 

 

 

 

✓ Scroll down to the Pre and Post Scaling Tendencies table 

 

 

The Excess Solute column shows that trace amounts of BaSO4 and CaCO3 are present in the water. 
These exceedingly small values (in the parts-per-trillion range) are the specifications or targets for 
the calculation. The software sets these target solid concentrations and then adjusts up or down, the 
BaSO4 and CaCO3 inflows until it reaches these targets. These part-per-trillion values may look 

arbitrary, but in fact the values are equivalent to 110-10 moles of solid/kg water. 

 

The pre-scale tendency for BaSO4 and CaCO3 equal 1.0 – by definition. That is, these are not 
calculated; they are defined. The remaining scale tendencies are computed.  

 

✓ Scroll down to the Brine Composition table 
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The dissolved Cl- is computed to be ~54000 mg/L. This is lower than the ~57000 mg/L entered 
initially in the Olympus 1 Brine Analysis. There are two reasons for this. First, the water volume 
increased because of thermal expansion (125 ⁰C vs. 25 ⁰C); and second, because the dissolved 
gases have increased the liquid volume (this is a smaller effect).  

 

This volume expansion can be seen in the Phase Properties table. The volume at reservoir 

conditions is 210.6 m3. At standard conditions, this liquid occupies 201.4 m3. The thermal 
expansion effect is the difference between 210.6 and 201.4 m3, and the dissolved gas effect is the 
difference between 201.4 m3 and the 200 m3 added.   

 

 

 

 

✓ Scroll down back to the Brine Composition table 

 

Notice that the dissolved Ca+2 changed from 600 mg/L to 611 mg/L. This is a combination of lower 
concentration due to liquid expansion, and an increased concentration because of the of the 41 mg/l 
Ca+2 added to saturate calcite. 

 

 

Task 6 – Recalculate the Scale Scenario with the Saturated Reservoir  

Considerable effort is taken to create a representative reservoir fluid. First, the Brine is entered, 
reconciled for charge balance, and if needed, reconciled for pH and alkalinity. Next, the gas 
composition is added, and the two fluids are set to equilibrium with each other and with important 
reservoir minerals. It is after these steps, and that a final scaling calculation is run. 

 

The Olympus 1 Reservoir calculation contains the representative fluid. It is, therefore, this Whole 
Fluid (multiphase) that will be used in all subsequent calculations. You will see the Whole Fluid in 
the Type column of all ScaleChem calculations. When Whole Fluid is selected, all phases of this 
fluid are included. 

 

You will use the Whole Fluid from the Reservoir to rerun the scaling calculations. 
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✓ Select the Olympus 1 Production in the Navigator Panel  

 

 

✓ Select the Design tab and then the Inlets tab (if not already there) 

✓ Select the gray cells to the left of the first two rows. This highlights the row. Then press the 
Delete key to remove the rows. 

  

 

✓ With the inlets now empty, select Whole Fluid as the Type  

✓ In the Name column, select Olympus 1 Reservoir  

 

 The Flow cell should display <Automatic> , meaning that the fluid mass (and volume) 

computed in the reservoir is being transferred to this object. 

 

✓ The Conditions tab does not need to be edited since the Locations with their respective T and 
P had been previously entered 

✓ Select the Solid tab and make sure the Standard box is checked  

 

✓ Calculate (Or press <F9> key) 

✓ Select the Plot tab and select View Plot 

The Whole Fluid type refers to all the phases within the fluid. The Automatic option takes the 
final flow rate phase of the separator and automatically enters this as the flow rate in the Scale 
Scenario calculation.  
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✓ Click on the [Default Plot] entry in the Plot Template Manager to reset the plot to its default 
variables. 

 

At Reservoir conditions (125C and 275 atm), the Calcite and Barite pre-scaling tendency are 1.0 by 
design. As production moves up the tubing, pressure and temperature decrease. CaCO3 scale 

tendencies decreases and reach a minimum at Separator conditions (60C and 30 atm). Barite 
scaling tendencies increase at each location because the temperature decreases, and barite 
saturation is temperature sensitive. 

 

✓ Save the file  

Summary  

The Saturator is a tool for creating a representative reservoir fluid. This calculation constrains the 
fluid to be in equilibrium with the minerals selected. This causes the fluid composition to be fixed for 
those precipitating ions. It becomes a compositional starting point for computing scale risk. 

 

The basis of this calculation is that water in the pores of a rock matrix is at equilibrium with the mineral 
surface. Some questions to consider are whether it is reasonable to assume that a reservoir gas, oil, 
water, and rock are in equilibrium. Furthermore, we should also consider over what vertical and radial 
distance we can make this claim. 

 

Regardless of the inconsistencies, the industry widely accepts this approach. It is up to the analyst 
to decide if the Saturator produces a more representative fluid than the original data. 
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 – Olympus Production 
Contour Plot 

Overview 

An alternative to the Scale Scenario calculation is the Contour Diagram. The Contour diagram 
calculation studies a range of temperatures and pressures. By comparison, the Scale Scenario 
studies specific production locations (wellhead, GLV, PLT, etc.), and generally no more than ten are 
entered. The purpose for using this object is to then create a matrix of temperature and pressure 
conditions and overlay a fluid’s properties, like scale tendencies, over it. 

 

You will need to have completed Chapters 2 to 4 before starting this chapter. 

 

Task 7 – Create an Initial Contour Diagram  

✓ Open the file used in Chapter 4. 

✓ Add a Scale Contour by selecting Calculations > ScaleChem > Add Contour or double-

clicking on Add Scale Contour in the Actions Pane  

✓ Rename the object Olympus 1 Contour 

 

 

✓ Select the Design tab  

✓ Select Inlet grid and choose, and under the Type column, select Whole Fluid using the 
dropdown arrow 
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✓ Select Olympus 1 Reservoir in the 2nd column 

✓ Keep the <Automatic> flow rate option in the 3rd column  

  

 

✓ Click the Conditions tab  

You will set the minimum conditions to the Separator (60C, 30 bar) and the maximum conditions to 

the Reservoir conditions (125C, 275 bar). Also, to create a reasonable number of calculations 
(~900) and to keep the matrix somewhat symmetric, you will use increments of 2 ⁰C and 10 bar. 

 
Temperature Range 

✓ Change the Start to 60 ⁰C 

✓ Change the End to 125 ⁰C 

✓ Select the Increment radio button - Enter 2 as the increment 

 

Pressure Range 

✓ Uncheck the Log box (if it is checked)  

✓ Change the Start to 30 bar 

✓ Change the End to 275 bar 

✓ Select the Increment radio button (uncheck the Log box first) 

✓ Change the Increment to 10 

  

 

This action creates 33 temperature and 25 pressure steps and produces a calculation matrix of 

3426 points, or 884 calculations. The calculation should take about fifteen minutes to converge, 
depending on the speed of your computer. 

 

✓ Select the Solid tab  

✓ Place a check next to the Standard box    

 

 

✓ Save the file  
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✓ Calculate  

 

A Calculation Dialog appears displaying the calculation queue. Developers at OLI Systems, Inc. have 
accelerated this calculation by refining the solver algorithm and have reduced the amount of data 
stored, to limit the file size. 

 

✓ When the calculation is complete, select the Plot tab  

 

Diagram 1: Total Solid Concentration 

 

The default plot is the total solids forming. The color scale represents a different numerical range. 
The red cells indicate heavier solid precipitation, and the faint purple-white in the center and left of 
the screen indicate that little to no scale forms. The upper right corner is the Reservoir conditions 

(125C and 275 bar). The lower left represents Separator conditions (60C and 30 bar). At both 
points, minimal solids are computed to form. The fluid traveling through the piping traverses this plot 
as temperature and pressure decreases. Layering production conditions (e.g., early to late life) over 
this plot provides an indication as to whether production will be at risk now or in the future. For 
example, if the pressure decline is significant (e.g., 60 bar), then the fluid will be unstable at the 
higher temperatures (bottom of well). 

 

This plot is a pixilated map of the thermodynamic properties of a produced fluid. The property plotted 
by default is the excess solids (total solids concentration). Many other properties can be viewed, 
which will be explained in the next task.  
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Task 8 – Exploring the Contour Variables 

There are a number of fluid properties that are worth exploring. These properties help us to 
understand the fluid behavior as temperature and pressure change. The first two properties to review 
are the BaSO4 and CaCO3 pre-scaling tendencies followed by a common fluid property, pH. 

 

✓ Select the Variables button on the top right of the diagram 

 

✓ Expand the Pre-scaling Tendencies category  

✓ Double-click BaSO4 (Barite) 

  

 

✓ Press the OK button and review the plot. 

  

Diagram 2: BaSO4 Pre-scaling Tendency 

 

The contour colors change horizontally, indicating that barite scale tendency is temperature 
dependent, and increases as temperature decreases. The pressure dependence is much weaker, 
and it seem to indicate that scale tendency decreases as pressure decreases.   
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✓ Select the Variables button  

✓ Expand the Pre-scaling Tendencies category then double-click CaCO3 (Calcite) 

  

Diagram 3: CaCO3 Pre-scaling Tendency 

 

Calcite has both a temperature and pressure dependence. As temperature decreases, the scale 
tendency decreases, but as pressure decreases, the scale tendency increases. The latter is because 
CO2 degasses, which causes the pH to increase. 

 

pH Diagram  

✓ Select the Variables button   

✓ Expand the Additional Stream Parameters category 

✓ Double-click pH – Aqueous  

   

✓ Press OK  
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Diagram 4: pH -Aqueous  

 

You will see an indistinguishable green plot. The scale to the right shows a range of 0 to 14 pH. This 
range is much greater than the pH range of the fluid, and needs to be modified in the Plot Options.  

✓ Select Options button  

✓ Click the Contour category  

✓ Check the two Auto boxes for Minimum and Maximum  

  

✓ Press OK to close the window and view the plot  
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Diagram 5: pH – Aqueous 

 

The pH is lower in the lower temperatures and higher pressures area in the top left of the diagram 
where the colors are the darkest red. At ambient temperatures, the pH jumps suddenly because of 
CO2 degassing at low pressures. We will evaluate the CO2 concentrations next. 

 

 There is one point where the pH is computed to be 3.65. This is the result of a calculation error, 
that existed in V10.0. If you do not see this, then you are using a newer version. 

 

CO2 (aq) Concentration 

✓ Select the Variables button  

✓ Select the Liquid-1 category  

✓ Double-click CO2-Liq1 

 

✓ Press OK  
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Diagram 6: CO2 – Liq1 Concentration  

 

As expected, the dissolved CO2 concentration changes with conditions. This is the key concentration 
that affects pH and calcite scale tendency. 

 

CO2 (vap) K Value 

You will next look at the equilibrium constant that governs CO2 solubility in the water. It is commonly 
referred to as the Henry’s Constant (KH). At ideal activities, the following pressure relationship exists:  

 

𝑲𝑯𝑷𝑪𝑶𝟐 = 𝒎𝑪𝑶𝟐  

This constant varies with temperature and pressure and this effect is visible in the Contour diagram. 

  

✓ Select the Variables button 

✓ Scroll down and expand the K-Values (m-based) category and select KCO2VAP: 
CO2VAP=CO2AQ 

 

 

✓ Press Ok, and review the plot  
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Diagram 7: CO2 – Vap K Value 

 

The diagram shows that KH is highest at low temperatures and low pressures, and decreases moving 
from lower left to upper right. Thus, increasing pressure and temperature decreases the value of the 
constant, and thus decreases the intrinsic CO2 solubility in water. CO2 is therefore, least soluble at 
high pressure and high temperatures. This is one reason why CO2 concentration in the water phases 
varies – there are others. For example, in Diagram 6, the region with the lowest CO2 concentration 
is in the lower right, but the KCO2 equilibrium, Diagram 7, has its lowest value in the upper right. Thus, 
there are additional factors controlling CO2 solubility. 

 

Summary 

This chapter introduced the Contour Diagram and discussed how one can use this in production 
applications. The contour diagrams are also used and to study the thermodynamic aspects of a given 
system.  
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 –Titan Production 

Overview 

Chapters 2 through 5 provided detailed instructions on using the following ScaleChem objects: 

• Brine and Gas Analyses, Scale Scenario calculation (Chapters 2 to 3) 

• Saturator Calculations (Chapter 4) 

• Contour Scale Calculation (Chapter 5) 

 

This chapter will cover the same calculation objects using fewer instructions.  Its purpose is to 
reinforce what was learned in chapters 2 – 5 and to promote the anticipating of next-steps when 
using the interface.  The chapter is divided into the following tasks:  

 
Task 1 – Add a New Brine  

Task 2 – Add a New Gas 

Task 3 – Add a New Reservoir Saturator  

Task 4 – Recalculate the Scale Scenario with Reservoir  

Task 5 – Add a New Contour Diagram  

The well is Titan 1, a hypothetical gas well with saline water (75000 mg/l TDS). The brine and gas 
compositions samples were taken after drilling the well. We will look at several aspects of this brine 
including, what scales may form during production, if solids will saturate at reservoir conditions, and 
how chemistry may change as pressure depletes. 

 

IT IS IMPORTANT, that you do this work in the file you created for Chapter 2 to 5 (Olympus well).  
Doing so will eliminate complications in Chapter 7. 

 

Task 1 – Add a New Brine  

✓ Open the SSC Basics file 

✓ Add a new Brine Analysis  

✓ Label it Titan 1 Brine  
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✓ Select the Design tab  

✓ Enter the Brine Analysis (cations/anions/neutrals) from the table below in the Data Entry grid  

Titan 1 Brine Analysis 

Cations mg/l Anions mg/l Neutrals mg/l Measured Data 

Na+1 30000 Cl-1 45000 B(OH)3 100 Temperature (C) 25 

K+1 600 SO4-2 50   Pressure (bar) 1 

Ca+2 150 HCO3-1  420   pH 7.1 

Mg+2 150 C2H3O2-1 350   Alkalinity 550 

Sr+2 50       

Ba+2 25       

Fe+2 2       

 

✓ Select the show non-zero option and keep the default balance option as Dominant Ion 

 

 

✓ Select the Reconcile (blue) tab  

✓ Enter the Measured Data from the table above  
(default temperature and pressure; 7.1 pH; 550 mg HCO3/L Alkalinity) 

✓ Select the Measured pH and Alkalinity calculation option  

 

 

The Alkalinity End Point pH will automatically display 4.5. This is the standard endpoint for a 
carbonate alkalinity experiment.  
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✓ Select the Calculate button or press the <F9> key 

 

 

 

✓ Save the file  

 

Task 2 – Add a New Gas  

✓ Add a new Gas Analysis  

✓ Label it Titan 1 Gas  

✓ Select the Expanded template  
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✓ Enter the following gas composition 

Formula Component name Mole % 

H2O Water 1.40 

CH4 Methane 74.00 

N2 Nitrogen 1.00 

CO2 Carbon dioxide 1.50 

C2H6 Ethane 6.40 

C3H8 Propane 4.00 

i-C4H10 Isobutane 3.00 

n-C4H10 n-Butane 3.00 

i-C5H12 Isopentane 2.00 

C5H12 n-Pentane 2.00 

C6H14 n-Hexane 0.50 

C7H16 n-Heptane 0.40 

iC8H18 Isooctane 0.30 

C8H18 n-Octane 0.30 

C9H20 n-Nonane 0.10 

C10H22 n-Decane 0.10 

 

✓ Check the Show Non-zero Only box 

  

Titan 1 Gas in Display Name View Titan 1 Gas in Formula View 

 

✓ Select the Reconcile (blue) tab 

✓ Calculate 

✓ Save the file   
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Task 3 – Add a New Saturator  

We do not necessarily know which species are likely to be saturated unless a mineralogy was 
provided. Therefore, using the saturator is a bit of an unknown factor. It is reasonable to create the 
saturator as before and select the standard solids but to not saturate a specific mineral. From this 
initial assessment, one can see which minerals are at or near saturation, and this can guide further 
decisions. 

✓ Add a Saturator  

✓ Label it Titan 1 Reservoir  

✓ Go to the Design tab and then to the Inlets (red) tab 

✓ Add the Titan 1 Brine at a flow of 100 m3/day 

✓ Add the Titan 1 Gas at 300 std E3m3/day  

 

✓ Enter the Reservoir Conditions of 160C and 470 bar  

 

✓ Select the Solid (blue) tab 

✓ Check the Standard solid box  

 

✓ Calculate  

✓ Review the pre-Scale Tendencies in the Report tab  
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Notice that BaSO4 is about 67% saturated, CaCO3 is about 32% saturated and FeCO3 is only about 

7% saturated. Based on this results there is no need to saturate with solids, and we will keep our 

original water analysis. 

So based on these results, would it be reasonable to saturate with all three solids? The only mineral 

that we could argue that we could saturate – to account for the worst case scenario – is Barite. 

✓ Go back to the Solids tab, and select Barite as the mineral to saturate, and BaSO4 as the inflow 
to vary. 

 

 

✓ Re-calculate 

✓ Review the pre-Scale Tendencies in the Report tab  

 

 

 

Notice that now the fluid is saturated with Barite (Pre-Scale = 1.0). 

 

Review the Brine Composition table. The original Ba+2 value has been overwritten to 32 mg/L.  

 

✓ Save the file   
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Task 4 – Add a New Scale Scenario  

Once the reservoir fluid is prepared, the next step is to compute scaling up the production line. 

 

✓ Add a Scale Scenario  

✓ Label it Titan 1 Scaling  

✓ Enter Whole Fluid –Titan 1 Reservoir into the grid 

✓ Keep the <Automatic> flow rate 

 

 

✓ Select the Conditions tab and enter the production conditions from the table below 

 

 Some of the names are not in the drop-down list. Therefore, type in the location names as 
necessary. 

 If your data is in Excel, Word, or other tabular format then you can copy and paste it into the 
conditions grid. Conversely, this grid can be copied and pasted to another scale scenario, or to 
external program.  

 

✓ Select the Solid tab then check the Standard box  
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✓ Select the Calculate button or press the <F9> key 

✓ Select the Plot tab 

 

The default plot shows pre-scaling tendencies for the five dominant scaling species.  

 

The results indicate that Barite becomes supersaturated as the fluid moves through the different 
locations. Starts at ST=1.0, because we defined that the fluid is saturated at the reservoir – but as 
we are producing the fluid, the scaling risk increases up to 4 at the surface. This is indicating that as 
the fluid starts to cool down at the surface, we start seeing the supersaturation of Barite going up. 

 

For a closer look at the solids that formed, we can adjust the plot parameters. 

 

✓ Select the Curves button  

 
 

✓ Select the Y1 Axis header to highlight all the Y1 variables then select the << button to remove 
the current variable 

✓ Expand the Solid category then double-click BaSO4 to add it to the Y1 Axis 
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✓ Press OK and view the Plot 

 

✓ Select the View Data button to see the solids’ concentrations at each location 

 
 

 

 

Save the file   
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Task 5 – Add a New Contour Diagram 

You will create a Contour plot for the Titan 1 Reservoir to gain additional practice  

✓ Add a Scale Contour  

✓ Label it Titan 1 Contour  

 

✓ Add the Whole Fluid, Titan 1 Reservoir 

✓ Keep the <Automatic> flow rate  

 

✓ Click the Conditions tab  

✓ Change the settings as follows 

Titan Contour 

Conditions Start End Increment Steps (calc) 

Temperature, ⁰C 70 160 2 45 

Pressure, bar 40 470 10 43 

 Make sure to uncheck the Log box for the temperature and pressure range 

 

✓ Select the Solid tab and select the Standard box 

 

 

✓ Save the file before running  

 The calculation may take 30 minutes 

 

✓ Calculate and look at the Plot  
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Titan Solid Concentration in Contour diagram 

 

 There are four points where the total solid concentration is very high. These are the result of a 
calculation error, that existed in V10.0. If you do not see this, then you are using a newer version. 
 

Notice that as pressure drops the scale concentration is computed to increase at higher 

temperatures. This plot is similar to the Olympus plot, and it can be inferred that the scale forming at 

lower pressures: a pressure-dependent scale, is either calcite, siderite, or both. The increased scale 

at lower temperatures (shade to darker blue moving to lower temperatures) is likewise, probably 

barite. That solid was shown to be temperature dependent in the Olympus case. 

✓ We can confirm these inferences, by plotting the CaCO3, FeCO3, and BaSO4 variables in the 
Solids category. 
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✓ Save the file  

Summary  

This chapter summarizes a production operation from start to finish. At this point, the calculation 
windows should start to look familiar and we should begin to anticipate the next steps.  
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 – Titan-Olympus 
Mixing and Production Facilities 

Overview 

This section presents a new calculation objects, Facilities. The Facilities is a simplified process 
simulator; it mixes and separates. It will be used to model the production facilities of the Olympus 
and Titan wells. Therefore, to this work, you must have completed Chapters 2 through 6 and have 
all calculations in the same file (you can download the file case from Chapter 2 through 6 HERE). 
 

Facilities Diagram 

The diagram below is the production schematic for the Olympus and Titan fluids (gas, oil, brine). 
Both wells are produced to the same separation facility. The flow of each well was set in the previous 
chapters when you created the Saturator (Reservoir) object. These same flows are used in the 
facilities scenario. Each process unit in the schematic below are modeled as a Node in the facilities 
object. Nodes contain inlet and outlet streams and are isothermal calculations (fixed temperature 
and pressure). The nodes also have the capability to separate phases (gas, oil, and solid) from the 
brine stream. There are several nodes in the scenario below, and some of them are used as 
separators. 

  

https://wiki.olisystems.com/wiki/File:SSC_Basics_-_Chapter_06.oad


OLI Studio: ScaleChem Basics: – Titan-Olympus Mixing and Production Facilities 7-2 

Modeling the Surface Facilities of the Olympus and Titan Fields 

In order to model this case realistically, we will start by adding a few additional waters to the file.  

Following that initial step, we will create the Facilities object  

✓ Select Calculations > ScaleChem > Add Facilities or select the Add Facilities action icon 

 

✓ Label it Topside 

 

 

✓ Select the Design tab 

 
The top of the Inflow Specs screen shows node diagrams, which we build in the bottom half of the 
screen. For each node, we add conditions, inlets (i.e. brines or other nodes), and outlets (i.e. new 
nodes). We can also separate gas, oil, or drop solids. 
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The following table contains the conditions for each production location (nodes) in this example. 
 

# Location Temperature (⁰C) Pressure (bar) Type Name 

1 Titan Reservoir 160 470 Whole Fluid Titan 1 Reservoir 

2 Titan Wellhead 110 170 Whole Fluid From Titan Reservoir 

3 Titan Choke 110 140 Whole Fluid From Titan Wellhead 

4 Olympus Reservoir 125 275 Whole Fluid Olympus 1 Reservoir 

5 Olympus Wellhead 100 100 Whole Fluid From Olympus Reservoir 

6 Olympus Choke 90 80 Whole Fluid From Olympus Wellhead 

7 Manifold 100 100 
Whole Fluid From Olympus Choke 

Whole Fluid From Titan Choke 

8 Flowline 80 90 Whole Fluid From Manifold 

9 HP Separator 60 60 Whole Fluid From Flowline 

10 LP Separator 50 20 Oil From HP Separator 

11 Oil Heater 90 15 Oil From LP Separator 

12 Gas Treatment 15 1 

Gas From HP Separator 

Gas From LP Separator 

Gas From Oil Heater 

13 Oil Treatment 15 1 Oil From Oil Heater 

14 Water Treatment 15 1 

Brine From HP Separator 

Brine From LP Separator 

Brine From Oil Heater 

Brine From Gas Treatment 

Brine From Oil Treatment 

 

✓ Click on the Add button 14 times, to add 14 nodes for the corresponding locations 

 

 

Next, we need to tell the software where the fluid is flowing through these nodes.   
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Task 1 – Create the Titan Reservoir 

✓ Double-click Node 1 then type Titan Reservoir as the name 

 

 

After naming a node, we work in the Node Input area to enter its conditions and inflows.  

✓ Enter Conditions of 160 ⁰C and 470 bar 

✓ Select Whole Fluid as the Type of fluid 

✓ Select Titan 1 Reservoir in the Name column 

✓ Keep the <Automatic> flow rate 

 

 

 

We will continue to add more nodes.  

 You also have the option to go to the Conditions tab to enter the names, T and P of each 

location. 

✓ Go to the Conditions tab and enter the information given below  
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✓ Go back to the Inflow Specs tab to complete the specifications for each node 

 

Task 2 – Titan Wellhead 

✓ Select the Titan Wellhead node 

✓ Confirm the Conditions of 110⁰C and 170 bar 

✓ Select Whole Fluid from as the Type of fluid 

✓ Select Titan Reservoir in the Name column 

✓ The flow rate appears as Calculated 

 

 When an inflow to a node comes from another node, the Flow column is automatically calculated.  
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Task 3 – Titan Choke 

✓ Select Titan Choke node 

✓ Confirm the Conditions of 110⁰C and 140 bar 

✓ Select Whole Fluid from as the Type of fluid 

✓ Select Titan Wellhead in the name column 

 

 

 

Task 4 – Olympus Reservoir 

✓ Select the Olympus Reservoir node 

✓ Confirm the Conditions of 125⁰C and 275 bar 

✓ Select Whole Fluid as the Type of fluid 

✓ Select Olympus 1 Reservoir in the Name column 

✓ Keep the <Automatic> flow rate 

 

 

 

Task 5 – Olympus Wellhead 

✓ Select the Olympus Wellhead node 

✓ Confirm the Conditions of 100⁰C and 100 bar 

✓ Select Whole Fluid from as the Type of fluid 
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✓ Select Olympus Reservoir in the Name column 

 

 

Task 6 – Olympus Choke 

✓ Select the Olympus Choke node 

✓ Confirm the Conditions of 90⁰C and 80 bar 

✓ Select Whole Fluid from as the Type of fluid 

✓ Select Olympus Wellhead in the Name column 

 

 

 

Task 7 – Manifold 

✓ Select the Manifold node 

✓ Enter conditions of 100⁰C and 100 bar 

✓ We will enter now two inlets for this node: 

o In the first row, select Whole Fluid from as the Type of fluid, and then select Olympus 
Choke as the Name 

o In the second row, select Whole Fluid from as the Type of fluid, and then select Titan 
Choke as the Name 

 

 

 

✓ The software will automatically calculate the flow for each brine 

 

Task 8 – Flowline 

✓ Select the Flowline node 

✓ Confirm the conditions of 80⁰C and 90 bar 

✓ Select Whole Fluid from as the Type of fluid 

✓ Select Manifold as the Name  
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Task 9 – HP Separator 

✓ Select the HP Separator node 

✓ Confirm the conditions of 60⁰C and 60 bar 

✓ Select Whole Fluid from as the Type of fluid 

✓ Select Flowline as the Name  

 

 

 

Task 10 – LP Separator  

✓ Select the LP Separator node 

✓ Confirm the conditions of 50⁰C and 20 bar 

✓ Select Oil from as the Type of fluid 

✓ Select HP Separator as the Name  

 

 

 

Task 11 – Oil Heater  

✓ Select the Oil Heater node 

✓ Confirm the conditions of 90⁰C and 15 bar 

✓ Select Oil  from as the Type of fluid 

✓ Select LP Separator as the Name  
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Task 12 – Gas Treatment  

✓ Select the Gas Treatment node 

✓ Confirm the conditions of 15⁰C and 1 bar 

✓ We will enter three different gases for this node: 

o In the first row, select Gas from as the Type of fluid, and then select HP Separator as the 
Name 

o In the second row, select Gas from as the Type of fluid, and then select LP Separator as 
the Name 

o In the third row, select Gas from as the Type of fluid, and then select Oil Heater as the 
Name 

 

 

 

Task 13 – Oil Treatment  

✓ Select the Oil Treatment node 

✓ Confirm the conditions of 15⁰C and 1 bar 

✓ Select Oil from as the Type of fluid 

✓ Select Oil Heater as the Name  

 

 

 

Task 14 – Water Disposal  

✓ Select the Water Disposal node 

✓ Confirm the conditions of 15⁰C and 1 bar 

✓ We will enter three different brines for this node: 

o In the first row, select Brine from as the Type of fluid, and then select HP Separator as 
the Name 

o In the second row, select Brine from as the Type of fluid, and then select LP Separator 
as the Name 

o In the third row, select Brine from as the Type of fluid, and then select Oil Heater as the 
Name 

o In the fourth row, select Brine from as the Type of fluid, and then select Gas Treatment 
as the Name 
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o In the fifth row, select Brine from as the Type of fluid, and then select Oil Treatment as 
the Name 

 

 

 

Task 10 - Reviewing the process  

After all the nodes are completed, the process should look like the image below. 
 

 

 Note: This application was meant to be basic mixing and separation with existing mass. There 

is no way to split stream, or recycles or controllers. That’s in the domain of the process simulator. 
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✓ Save the file  

✓ Select the Conditions (blue) tab 

 

A summary of the process is shown in Conditions tab 

 

 

✓ Select the Solids (red) tab 

✓ Check the Standard box 

 

 

✓ Click on the Calculate button  

✓ Select the Plot tab when the calculation is complete 
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The default plot displays the standard Pre-scaling Tendencies vs locations. It is important to 
recognize that in this plot four different scenarios are shown. The results for Titan Reservoir, the 
results for the Olympus Reservoir, the results for mixing the fluids of these two reservoirs and 
separation, and the results for treatment.   
 
For the Titan and Olympus reservoirs, we knew that they were going to be supersaturated with Barite 
at the surface. We see that when these two fluids are mixed together at the Manifold location, the 
scaling tendency start to increase. The Barite saturation at the HP Separator increases up to a value 
of 5.0. Additionally, notice that at the Manifold appears the risk of FeS scaling. The reason why we 
see the formation of this scale, is because the Olympus reservoir contained H2S in the gas phase, 
while the Titan reservoir contained Fe+2 in the brine. As a result, we see supersaturation with FeS 
and the scaling risk increases as the fluid moves towards the Separator. 
 

✓ Save the file  

 

Summary  

This is a basic Facilities calculation. There are multiple uses for this function particularly when a full-
fledged process simulator is too advanced for the application. 
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 – Bathos P-101 
Production  

Overview  

Chapter 8 is a case modeled after a South Texas well. The Bathos P-101 well produces a light oil (API 41) 
with an associated gas. The reservoir is a calcite-cemented sandstone at moderate temperature/pressure 
(93.3⁰C, 220.6 bar). The produced water contains about 50,000 mg/L TDS. The reservoir requires water 
injection, and a tertiary aquifer water with moderate incompatibility is currently the best choice. The injection 
and mixing scenario is also simulated. 
  

Setting up the OLI Studio File 
 

✓ Start the OLI Studio and start working from a new file  

✓ Before adding any objects, click on the top-level object in the Navigator Panel 

 

  

 

✓ Go to Calculations  > Model Options  

 

 

✓ Select the MSE-SRK (H3O+ ion) Thermodynamic Framework 
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✓ Name the file Bathos-GS Scenario and Save the file 

 

 

 
 

Task 1 – Create the Bathos P-101 Brine  

The brine’s composition is given in the table below.  

Bathos P101 Brine Analysis 

Cations mg/L Anions mg/L Neutrals mg/L Measured Properties 

Na+1 15260 Cl-1 24500 B(OH)3 107 Temperature 25⁰C 

K+ 180 SO4-2 160 SiO2 60 Pressure 1 atm 

Ca+2 850 HCO3-1 See alkalinity*   pH 6.7 

Mg+2 135 C2H3O2-1 386   Alkalinity (mg (HCO3/L)) 673 

Sr+2 65     Density (g/mL) 1.026 

Ba+2 1.3     Econd (mho/cm)  

Fe+2 2.1     TDS (mg/l)  

*This is case were the total alkalinity was measured, but not the inorganic carbon. A good initial/guess value 
for the bicarbonate ion then is the total alkalinity value. 
 

✓ Add a Brine Analysis -  

✓ Label it Bathos P-101 Brine 

 

 

 

✓ Select the Design tab 

✓ Enter the composition from the table above in the Data Entry grid 

✓ Select the Show Non-zero Only box 

✓ Look in the lower right of the Summary box and note the charge balance output 
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The software added approximately 408.5 mg/L of Cl- to balance the charge imbalance of 0.012 eq/L. Notice in 
the Data Entry grid that the balanced Cl- concentration (yellow column) is 24908.5 mg/L. 
 

✓ Select the Reconcile (blue) tab 

✓ Enter the measured pH (6.7), Alkalinity (673), and density (1.026) 

✓ Select the Measured pH and Alkalinity option 

 

 In this case we have a bicarbonate (HCO3-1) value that is different from the Alkalinity value. This is 
because the bicarbonate was measured separately from the organic acids. This means that we have enough 
information to distinguish between bicarbonate and alkalinity.  
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✓ Click on the Calculate button or use the <F9> key  

 

 
Notice that 408.5 mg/L of Cl- were added to balance charge, 66.95 mg/L of inorganic carbon as CO2 were 
removed to balance alkalinity, and 122.6 mg/L of HCl were added to adjust pH. 
 

Task 2 – Create the Bathos P-101 Crude Oil 

You will create an oil analysis using assay data.  

✓ Add an Oil Analysis  

✓ Label it Bathos P-101 Oil 

 
The Oil Analysis’s Design menu has 
four screens noted by a colored tab: 
Combined (orange) tab, 
Pseudocomponents (blue tab), Assay 
(red tab), and Reconcile (teal tab). 
Three of these tabs allow the user 3 
different ways of entering data. 
 

 The Combined tab is used to enter 
pure components, the 
Pseudocomponents tab is used to 
enter the different pseudocomponents 
that make an oil sample, and the Assay 
tab that allows to enter a distillation 
curve. 

 

 

✓ Click the Assay (red) tab  
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The Assay screen contains three data entry grids: Component, Entry Options and Distillation Data. The 
Appendix at the end of this chapter explains assay options in further detail. 

 

 
The data to be entered is shown in the two tables below. The first table contain the assay specifications, name, 
fraction, measurement type, etc. The second table contains the experimental data. 
 

 Component    Distillation Data 

 

Name ASSAY  

 

Volume% Temperature(°C) 

Mole% 98.4 1 26 

Entry Options 5 41 

(experiment) Type ASTM D86 10 65 

Thermo Method API-8 20 88 

Density value 41 30 102 

Density units API Gravity 40 129 

No. of Cuts 12 50 167 

 60 208 

 

70 241 

80 279 

90 342 

95 358 

100 397 

 
Under Component, type the name ASSAY in the <Enter Assay Name> cell.  Press the <Tab> key to move to 
the next cells. 

 The name cannot be longer than 5 characters.  
 

✓ Enter the value, 98.4 in the mole% cell 

 This instructs the software that the assay represents 98.4% of the total hydrocarbon mass. The remaining 
1.6% are inorganic gases CO2 and N2 – that we will enter in the combined tab.  

 

✓ Change the Analysis Type to TBP CURVE  

✓ Select API-8 as the Thermo Method 
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✓ Enter the value 41 in the Density box  

✓ Select API Gravity  

✓ Change the No. of cuts to 12 

✓ Enter the Volume% and Temperature data from the given table above in the Distillation Data 
grid 

 

✓ Click on the Display Assay Cuts button 

 

The Assay cuts are pseudocomponents. They combine to represent the overall crude oil. Each 

pseudocomponent has a name: “Assay_NBPK”, which is the name Assay you entered plus the 

normal boiling point in Kelvin. The next three columns are the molecular weight (Mol Wt.), boiling 

point (NBP), and specific gravity (Sp Gr) computed using the distillation data and the experimental 

type specification. The remaining columns are four key critical properties. There are a total of 

fourteen critical properties generated, and these are found in the individual tabs at the bottom of 

the table. 

 
 

The next step is to add the inorganic data 

✓ Click on the Combined tab 
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✓ Scroll down the list and look for N2 and CO2 and enter the following concentrations: 

Component Mole% 

N2 0.5 

CO2 1.1 

 

✓ Click on the Show Non-zero Only box 

 
When done, the combined grid should look like the one below 

 

 

Task 3 – Add a Gas 

✓ Add a Gas Analysis –  

✓ Label it Bathos P-101 Gas 

✓ Make it 100 mole% CH4 

✓ Click on the Show Non-zero Only box 

 

 

 

Task 4 – Add a Saturator  

You will combine the brine and oil analysis at reservoir conditions, and saturate the combined fluid with 
CaCO3. 
 

Bathos P-101 Saturate 

Type Name Flow 

Brine (bbl/day) Bathos P101-Brine 850 

Oil (std bbl/day) Bathos P-101-Oil 2200 

Gas (std Mft3/day)  Bathos P-101-Gas 300 

Reservoir Conditions 

Temperature, ⁰F 200 

Pressure, barg 220 

 

✓ Add a Saturator –  
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✓ Label it Bathos P-101 Reservoir 

✓ Change the Reservoir Units to Scale English (select the Saturator object and then click on the 

units manager icon  )  

 

 

 

✓ Click on the Customize button to change the units of pressure to barg 
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✓ Select the Design tab and then go to the Inlets tab 

✓ Under Type enter Brine, Oil and Gas with the flows given in the above table 

 

 

 

✓ Enter the Bathos P-101 Reservoir conditions of 200°F and 3200 psia 

 

 

✓ Select the Solid tab a check in the Standard solids box  

 

 

✓ Check the Calculate Alkalinity box 

✓ Click on the Calculate or press the <F9> key 

 

 

 

 The calculate button will be yellow. This is indicating that solids need to be selected for saturation. However, 
for this case you will calculate the CaCO3 scale tendency before saturating, to see how close it is to saturation. 
So, the Reservoir Mineral Saturation step will be skipped. 
  

✓ Click on the Report tab and review the Scale Tendencies table. 

 

✓ Let’s analyze how far or close to saturation some of these minerals are. 
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Calcite is about 75% of saturation. All other minerals are sub-saturated. So, it is reasonable to set this mineral 
to saturation to account for maximum risk conditions. 
 
You were instructed to calculate alkalinity. This is because if calcite will be reservoir-saturated then the 
composition effects on properties should be monitored. 
 

✓ Record the calculated Alkalinity in the Phase Properties table. 

 

 

✓ Return to the Design tab > Solid tab, and saturate Calcite by adding CaCO3 inflow 

 

 

✓ Calculate and review the top table in the report (Saturation Details) 
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According to the calculation, 60 mg/L CaCO3 is added to saturate calcite mineral. This converts to 24 mg/L 
Ca+2 and 36 mg/L CO3

-2. 
 
The overall change is nominal to total dissolved Ca+2. It increases about 3%, from 850 mg/L to 874 mg/L. CO3

-

2, on the other hand, increases by 36 mg/L, which increases the alkalinity by 13%, from 689 to 762 mg/l as 
HCO3

-1. 

 

 
The Ca+2 change is small, and perhaps within the sampling, experimental, and fluid representation uncertainty. 
A Similar argument for the total alkalinity is less tenable. 
 
So, this means that this was probably reasonable to saturate with Calcite. 
 
The next analysis is to review the hydrocarbon tables, to review the data provided, including the water and 
CO2 content in the oil phase 
 

✓ Scroll down to the Oil Composition table 
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The water content is 0.49 mole%. This water mass was transferred from the brine phase. The dissolved CO2 
is 0.87%, which is less that the original value entered of 1.1% (in the oil composition). This reductions is due 
to the transfer of CO2 to the brine phase.  
 
Lastly, check the brine volume (at standard conditions vs reservoir conditions) in the Phase Properties table. 
 

 

Compare the values to the initial 850 bbl/day of Brine (added to the Saturator object). Notice that the difference 
between the flow measured at the separator vs the calculated at reservoir conditions is 21.28 bbl/day. This 
indicates that some water gets transferred to other phases along the production line. 
 
Also notice that the results don’t include the gas phase. This is because the gas phase has been condensed 
into the oil phase. 
 

Task 5 – Add a Scale Scenario  

The final task is to calculate scaling tendencies.  

✓ Add a Scale Scenario  

✓ Label it Bathos P-101 Scale Scenario 

✓ Change the Scale Scenario Units to Scale English (select the Saturator object and then click on 

the units manager icon  )  
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✓ Click on the Customize button to change the units of pressure to barg 
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✓ Select the Design tab and then go to the Inlets tab 

✓ Under Type select Whole Fluid, Bathos P-101 Reservoir, and <Automatic> 

 
The grid should look like the one below. 

 

 

✓ Select the Conditions tab, and enter the following information:  

Location Temp (F) Press (barg) 

Original Reservoir 200 220 

Current Reservoir 200 160 

Flowing Reservoir 200 150 

Bottomhole 200 147 

2600' 190 166 

1300' 180 80 

Wellhead 170 54 

Flowline 150 33 

Separator 140 9.3 

 
The screen should look like the one below:  
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✓ Select the Solid tab and select the Standard checkbox  

 

✓ Calculate or press the <F9> key  

✓ Select the Plot tab  

✓ Open the Variables window and check all the boxes at the bottom of the window 

 

✓ Close the window and review the results 

 

Notice that overall there is not scale risk. There is saturation in the original, current and flowing reservoirs and 
in the Bottomhole.  
 
Once you reach the 2600 location – the risk of calcite scale formation goes down. When you get to the flowline, 
nothing is supersaturated. But then you get to the Separator, Calcite gets slightly supersaturated.   
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Let’s have a look at the amount of solids. 
 

✓ Change the Y1-axis Variables to CaCO3 (Calcite) - Sol 

 

 

 

You can see that the Original Reservoir has no scale risk. Overtime as the reservoir pressure drops, up to 27 
mg/L of CaCO3 precipitates out of the fluid (current reservoir). As the fluid flows through the well (flowing 
reservoir) another 4 mg/L of CaCO3 precipitates out. The total material in the reservoir, i.e. the 32 mg/L of 
CaCO3, is assumed to stay in the rock itself. At the bottomhole, is where we will start seeing 33 mg/L of CaCO3 
scale. At the other locations, everything else is computed to be sub-saturated, until we reach the Saturator, 
where 21 mg/L of CaCO3 precipitates out.  
 

✓ Go to the Report tab, and look for the Separator results. 
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At the separator, the software computes that there are 4 phases present: water, vapor, solid and organic phase.  
 
Since the fluids were measured at the separator, we want to make sure that the software is predicting the 
same measured values.  
 
For the brine or liquid, we have that the software is predicting 849 bbl/day – and at the separator it was 
measured as 850 bbl/day. This is a good prediction.  
 
For the organic phase, the software is predicting 2214 std bbl/day vs 2200 std bbl/day being produced.  
 
And, for the gas phase, we had 300 std Mft/day being produced, vs 275 std Mft/day. So, we are off by about 
8% here.  
 

✓ Save the file  

Summary  

This is another typical well, with similar procedures to previous chapters.  The difference is that this chapter 
introduced the oil analysis object.  There are a few errors that were overlooked, including the missing water in 
the oil analysis and the missing dissolved CO2 in the water.  This could have been resolved by adjusting the 
two analyses, or by creating a makeup water or CO2 stream.  Both options will be considered in the advanced 
section of the ScaleChem training manual.  
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Appendix: Assay Entry Options 

There are four Assay types. These are experimental methods used to create distillation curves. 
 

 

 

• ASTM D86 runs at atmospheric pressures and is used for all oil types. 

• ASTM D1160 runs at vacuum pressures and is used for heavy oils. 

• ASTM D2887 runs on a gas chromatograph and is used for light oils. 

• TBP CURVE refers to true boiling point curve. 
 
There are four methods for calculating thermodynamic properties, API, Cavett and Lee-Kessler. 

 

 

• API-8 and API-5 are methods that use specific gravity to determine critical parameters. 

• Cavett is a method to determine critical parameters using the API gravity. 

• Lee-Kessler is a method to determine critical parameters by using the Watson K. 
 
There are three average bulk density options, Specific Gravity, API Gravity, and Watson K.  

 

 

• Specific Gravity is the ratio of the material density to water. Studio ScaleChem requires specific 
gravity to be between 0.228 and 1.6 

 

• API Gravity is defined by the following equation: 
 

𝐴𝑃𝐼 ሺ60𝐹ሻ = ൬
141.5

𝑆𝐺ሺ60𝐹ሻ
൰ − 131.5 

 

• Watson K is a method that relates density to boiling point.  
 

𝐾 =
ሺ𝑁𝐵𝑃ሻ

1
3

𝑆𝐺
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 – Injection Water 
Mixing in Bathos Reservoir 

Overview 

A common question in production chemistry is whether injection water and reservoir fluid are 
compatible. In this chapter, we will look at how the OLI Studio: ScaleChem feature called Mixing 
Water can help answer this question. We will continue working with the Bathos case.  

The Mixing Water feature calculates fluid properties when two brines are mixed. For this calculation, 
we select up to two brines to mix. We can also add a single gas or a single oil phase, and select 
solids. Then we designate whether the mix should take place by a flow rate or a ratio. The software 
changes the relative volumes of each fluid to create a combined fluid at the selected ratio or flow 
rate. The total brine, gas, or oil flow rates do not change during the calculation. The resulting plotting 
screen is identical to the scale scenario. We define the mixing ratio as the ratio of brine that comes 
from the first brine. 

 

Task 1 – Create an Injection Water 

For this example, the injection water will be Seawater. 

✓ Go to the menu and select View > Toolbars > Object Library 

✓ From the Standard Objects window (that appear on the right-hand side of the window) select 
the option Sea Water   
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✓ Click on it and drag it to the Navigator Panel, and name it Seawater 

✓ Change the Thermodynamic Framework of the Seawater to MSE-SRK 

 

 

 

✓ Select the Reconcile tab  

✓ Select the Concentration Data Only 

✓ Calculate then save the file 

 

 

The software added 2.99 mg/l Na+1 to balance the charge.  



OLI Studio: ScaleChem – Injection Water Mixing in Bathos Reservoir 9-3 

Task 2 – Add a Mixing Water Calculation 

We are going to assume seawater breakthrough and we are mixing at the. And in this case, we are 

mixing with the Bathos water.  

✓ Add a Mixing Water calculation and name it Seawater Injection – Bathos 

✓ Change the units of the Mixing water object to Scale English Units  

 

 

 

✓ In the Inlets tab, enter the First Brine, Seawater Injection - Bathos 

✓ For the Second Brine, select Bathos-P101 Reservoir 

 

 

 

 The Mixing Water’s Design tab opens to the Inlets screen. It contains First Brine, Second Brine, 

and the standard inflow row. It is not entirely clear, but the flow cell on the First brine row is in fact 

the total flow of water = first + second brine (they are not separate).  

 The flow of the First Brine will be varied to do the mixing study, and it will appear in the x-axis in 

the default plots.  

✓ Enter the mxing conditions of 200°F and 147 barg  

 

 The 147 barg is the injection well pressure, and this added pressure will impact the 

thermodynamic stability of the interfaces; oil-water and mineral-water.   
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✓ Select the Conditions tab 

✓ Change the mix type to Ratio  

✓ Change the Steps to 10 

✓ Press the Auto Step button 

 

 

When complete, the grid should look like the following. The first row represents 100% Seawater and 
the last row represents 100% Bathos brine at 10% intervals.  

 

 

 

✓ Select the Solid tab then check the Standard box 

 

 

 

✓ Press <F9> to calculate and save the file  
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The plot should look like the one below 

 

 

The plot shows that we could possibly form a Magnesium silicate phase (Mg3SiO2O5(OH)4. This is 
because now we are introducing other species that come with the seawater composition. However, 
this phase is not being formed (the amount of solids for this phase is zero), so we can remove it from 
the plot to make it easier to read. 

 

Let’s modify the plot to show the pre-scaling tendencies of interest. 

 

✓ Click on the Variables button 

✓ Remove the Dominant Pre-scaling Tendencies from the Y1 Axis and add the phases shown 
below, then click OK.  
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The plot should look like the image below. 

 

So now, what we see here is the different results from no sea water (0%) to 100% sea water – which 
is the last point to the right. 

 

Notice that if we inject 100% seawater into this reservoir calcite will be automatically super-
saturated. You can also see that barite has a bell shape like curve, which is an indication of 
incompatibility. Celestine also shows a little hump at higher ratios and is another example of 
incompatibility. The other solids like anhydrite and gypsum have pre-scaling values below 1.0, so 
we don’t have to worry about incompatibility. Therefore, mixing these two fluids at injection water will 
have incompatibility problems.   

 

We can also study the amount of solids that are computed when we mix these two brines. 

 

✓ Go to the Variables button 

✓ Go to the solids category and select barite, calcite and celestine. Click OK. 

 

The plot should look like the image below. 
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Calcite forms at both extremes – at 100% seawater and 100% bathos reservoir brine - celestine 
stats forming at about 30% sea water until 100% bathos fluid. Barite forms at almost all the ratios, 
with a small mineral concentration.  

 

✓ Save the file  

 

Summary 

The Mixing block is a basic tool for testing incompatible waters. It adjusts the flow of two brines and 
holds the remaining inflows (like oil or gas) constant. This is done at a single T/P condition and the 
total brine flow is fixed. More complicated mixing calculations are presented in later chapters. 
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Chapter 10 – Offshore High-
Pressure Gas Production with 
Low Water Cut 

Overview 

This chapter is intended to reinforce the training elements of Chapters 2 through 6 and to introduce 
mass balance to production chemistry analyses. This case is of several offshore wells producing a 
gas-condensate. They produce a high gas-water ratio (GWR) fluid, and the production chemist is 
certain that the produced water sample collected has been diluted with condensed water from the 
gas phase. The water sample was taken at the separator, and the water production rate is based on 
flow from this unit.  

 
 
The table below contains the production conditions that will be used in this case.   

Variable Value Units 

Water flow 28 m3/day @ separator 

Gas flow 2100 Std E3m3/day at separator 

Separator Temperature 40 ⁰C 

Separator Pressure 60 bar 

Reservoir Temperature 205 ⁰C 

Reservoir Pressure 1380 bar 
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To simplify the procedure, the wells are combined into one, and a single produced fluid is created.   
To make this simplification, the assumption is that the water and gas compositions and reservoir 
conditions are identical in each well.  
 

Task 1 – Add a Brine Analysis 

✓ Launch the software or select File > New (if the software is already started) and Save as 
Chapter 10 – High GWR 

✓ Click on Streams and change the name to High GWR production 

 
 

✓ Select High GWR production and go to Chemistry > Model Options… 

 
 

✓ Under the Databanks tab select the MSE-SRK (H3O+ ion) as the Thermodynamic Framework, 
and click OK. 

 

 

✓ Add a Brine Analysis  

✓ Label it Separator Water 

  

✓ Enter the data from table below into the Design > Data Entry grid 

Analysis of the water sampled at the separator 

Cations Conc, mg/L Anions  Conc, mg/L Neutrals Conc, mg/L Measured Properties Value 

Na+1 3600 Cl-1 6350 B(OH)3  
(Boric acid) 

18 
Temperature (⁰F) 100 

K+ 27 SO4-2 1.5 Pressure (atm) 1 

Ca+2 550 HCO3-1 39.5   pH 6.9 

Mg+2 5     Alkalinity (mg HCO3/L) 44.5 

Sr+2 0.2     Density (g/mL) 1.1125 

Fe+2 1.6     Conductivity n/a 

Ba+2 1.6     Total Dissolved Solids 174956 
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The brine composition is simple. The pH and alkalinity are reported.  
 

✓ Change the Entry Options to Formula to make components easier to enter 

✓ After entering the data, check the Show Non-zero Only box -  

 
The screen should look like the one below 
 

 
 

✓ Click the Reconcile tab 

✓ Add the Measured Properties from the table above (6.9 pH, Alkalinity of 44.5 mg HCO3/L, 
Density of 1.1125 g/mL, and TDS of 174956 mg/L)  

✓ Select the Measured pH Only button and select the Calculate Alkalinity box 

✓ Calculate 

 
  

The computed pH now match the measured value. The density, alkalinity and conductivity are also 
computed.   
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Task 2 – Add a Gas Analysis 

The production gas is in the table below. It is a combination of light gas with some condensate 
components. We will enter the data into the Gas Analysis object. 
 

Component Display Name Mole% 

H2O Water 0.0 

N2 Nitrogen 1.0 

CO2 Carbon dioxide 1.4 

CH4 Methane 93.75 

C2H6 Ethane 2.0 

C3H8 Propane 0.8 

i-C4H10 Isobutane 0.1 

n-C4H10 n-Butane 0.2 

i-C5H12 Isopentane 0.5 

n-C5H12 n-Pentane  0.1 

C6H14 n-Hexane 0.15 

 

 There are several isomers and depending on your version, the Formula view may be 
indistinguishable. Change the display option to Display Name or OLI Tag if you encounter this 
problem. 
 

✓ Add a Gas Analysis  

✓ Label it  Produced Gas 

 

 
 

✓ Select the Design tab > Inflows tab 

✓ Enter the data from Table 2 into the Inflow grid 

 

 Toggle the Display between Display name and OLI Tag if you need to distinguish between 
isomers 

 
 

✓ Check the show non-zero Only option  

 
The completed screen should look like the one below 



OLI Studio: ScaleChem Basics – Offshore High-Pressure Gas Production with Low Water Cut 8-5 

 
 
The gas-phase water content rarely given, but in this case it is important, because the gas-to water 
ratio is high. There are several ways to calculate the water content, which we will investigate in later 
chapters. For now, we will calculate the water content manually, by equilibrating it with the brine. 
 

Task 3a – Calculate the H2O Content in the Gas 

We are given the fluid composition and conditions at the separator unit. We can start with the 
assumption that the hydrocarbon and brine are in equilibrium at this point. If this is true, then we can 
calculate the H2O saturation concentration in the gas phase.  
 

✓ Add a Saturator object -  

✓ Label it Separator 

✓ Add the following inlets, and flows 

Type Name Flow Units 

Brine Separator Water 28 m3/day 

Gas Produced Gas 2100 Std E3m3/day 

 
Your screen should look like the following 
 

 
 

✓ Enter the Separator Conditions: 40⁰C and 60 bar 

 
 

✓ Calculate and when done Click the Report tab 
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✓ View the Volume in the Phase Properties table (results may differ) 

 
 
Notice that Brine volume decreased from 28 to approximately 25.54 m3/day, this is a 2.46 m3/day 
decrease. The roughly 2.46 tons of H2O mass partitioned to the vapor phase. This is because the 
produced gas analysis did not include the H2O fraction, and so material was missing from the gas 
analysis. 
 
This 2.46 ton decrease equates to 136.13 kgmol of H2O. Let’s confirm the mass or mole transfer 
using the data in the reports and by manually calculating this transfer of water. 
  

✓ In the Phase Properties table, record the moles of Vapor, i.e. 89201.3 kgmol/day 

✓ Scroll down to the Gas Composition table  

✓ Record the fraction of H2O in the gas, i.e. 0.153 mole% 
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✓ Calculate the H2O moles in Gas phase 

 

𝑀𝑜𝑙𝑒𝑠 𝐻2𝑂 𝑖𝑛 𝐺𝑎𝑠 =
0. 152605 𝑚𝑜𝑙%

100%
× 89201.3 𝑘𝑔𝑚𝑜𝑙 = 136.1256 𝑘𝑔𝑚𝑜𝑙 

 

Thus, we can see that saturating the hydrocarbon gas consumed 136.5 kgmol. This represents the 
missing water mass or rather, the water unaccounted for in the gas analysis. It needs to be added 
to the gas analysis so that the case is compute with no mass-balance error. 
 

Task 3b – Add the Missing Water 

There are a few ways to saturate the gas with water: 
 

• The first is to simply modify the gas analysis with ~0.153% H2O reported in the Saturator 

calculation 

• The second is to saturate the gas with water using the Reconcile tab of the gas analysis 

• The third is to create a makeup H2O stream that flows at 2.46 m3/day 

This latter option is easy to rationalize, because the original gas analysis does not need to be 
modified, and using the makeup water approach reinforces the thrust of this exercise: conserving 
mass balance. 
 

✓ Click on the Global Stream High GWR production object to expose all the objects in the 
Action pane 

 
 

✓ Click on the Add Stream object to create a new stream –   

✓ Label it Makeup Water 

 

 The stream object is part of the Stream Analyzer software in OLI Studio. Its default settings are 
1 kg water (55.508 moles) at 25⁰C and 1 bar. 
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We do not need to modify this at all. The default settings make it ideal as a makeup water stream. 
The mass is not what is desired, but this will be modified in the Separator. 
 

✓ Click back on the Separator object –  

✓ Go back to the Design tab 

✓ In the Inlet tab, enter a third row, select: Whole Fluid, Makeup water and 2.46 m3/day 

 

 
 

✓ Calculate and go to the Report tab 

✓ Review the (brine) volume in the Phase Properties table  

 

 
 

The volume is now 28.01 m3/day (exiting the separator). This value is now consistent with the 
reported production rates. 

✓ Scroll down, and review the Gas composition table– specifically the H2O composition 

 
 
These water fraction now represent the equilibrium partitioning among the water and gas phase.   
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Assume Mass is Conserved from the Separator to the Reservoir  

The previous calculation closed the mass balance between the reported flows and the computed 
flows, at least for the water flow rate. It may also be necessary to close the mass balance for the gas 
and condensate rates, but for now we will limit this study to the water balance. 
 

Separator 
T/P known

Equilibrium exists

Production
Mass/Moles in

Gas 
Mass/Moles Out

Condensate
Mass/Moles Out

Brine
Mass/Moles Out

Production Mass In = Gas+Oil +Brine Mass Out

 
 
The next step is to close the mass balance from the separator back to the reservoir. If we assume 
that no mass is lost as the fluid travels from the reservoir to the separator, then there is no additional 
work needed.   

 
 
So, for this case, the fluid mass (gas+oil+water+solid) exiting the reservoir equals the fluid mass 
entering and then exiting the separator. This may be a bad assumption, especially since it presumes 
that no scale builds up in the production line.  
 
We will proceed by creating a second Saturator block. This block will represent the reservoir 
conditions and the mass from the separator will be sent to the reservoir, thereby closing the mass 
balance. 
 

Task 4 – Create a Reservoir Object and Input the Separator Fluid 

✓ Add a Saturator object from the Action panel –  

✓ Press the <F2> key or use the Description tab to rename it Reservoir 

✓ In the Design tab > Inlets tab, select Whole Fluid, Separator, and <Automatic> flow 

 

 Make certain that you select Separator, and not Separator water 
 

 

 The Automatic flow means that 100% of the Separator mass is transferred to the Reservoir  

Solids may form

Mass Exiting Reservoir = Mass entering Separator 

(less solids fouling equipment)
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✓ Enter the reservoir Conditions of 205⁰C and 1380 bar 

 

 
 

✓ Click on the Solids tab and check the Standard solids box 

 

 

✓ Calculate 

✓ Click on the Report and go to the Phase Properties table 

✓ Check the (brine) volume (Liquid-1 column and confirm that the volumes are in m3/day) 

 

 
 

The brine volume at reservoir conditions is 0.37 m3/day. This is a 75% volume reduction (from 28 
to 0.37 m3/day) (results may differ depending on version).   
 
The remaining amount of water (i.e. 27.63 m3/day) shifted to the oil phase. This is due to the change 
in T/P conditions. The result of this mass transfer is a reservoir water composition that differs 
dramatically from the water sampled at the surface.   



OLI Studio: ScaleChem Basics – Offshore High-Pressure Gas Production with Low Water Cut 8-11 

✓ Scroll down to the Brine Composition table 

✓ Review the ions concentrations 

 
Notice, for example, that the Na+ and Cl- concentrations are 76-times higher at reservoir conditions. 
 

✓ Scroll up to the Pre and Post Scaling Tendencies table 

 

 
 
Halite is near saturation, its saturation ratio (pre-scale value) is 0.87. Two other phases, CaCO3 and 
BaSO4 are computed as supersaturated, and their respective Excess Solute in mg/L are 65.14 and 
2.89 respectively.  
 
These reservoir results are, we think, representative of what enters the well. The next step is to study 
the fluid properties as it flows to the surface. 
 

✓ Save the file  
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Task 5 – Calculate the Scaling Scenario 

The scaling scenario is run the same way as previous calculations. Enter the Reservoir whole fluid 
and test it at various T/P conditions.  

✓ Add a Scaling Scenario from the Actions panel -   

✓ Label it Production Conditions 

✓ Select Whole Fluid, Reservoir, and <Automatic> flow  

 

 
 

✓ Click on the Conditions tab 

✓ Enter the following conditions into the grid 

 

Offshore Production Conditions 

Location Temp (C) Press (bar) 

Reservoir 130 650 

Bottomhole 130 630 

SSSV 70 340 

Tubing head 65 320 

Choke 60 280 

Flowline 5 200 

Separator 40 60 

 
The grid should like the image below.
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✓ Click on the Solid tab then select the Standard solids button 

 
 

✓ Calculate or select the <F9> key  

✓ Click on the Plot to review the Pre-scale tendencies 

 

 
 
Four minerals are supersaturated: Calcite, Aragonite, Barite and Halite. Halite is slightly sub-
saturated at all conditions; we will investigate this later. Before this, we will confirm the computed 
and reported separator volumes (i.e., confirm earlier calculations). 
 
 

✓ Click on the View Data button to review the data –  
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The table shows two notable results. The first is that scale tendencies for Calcite, Aragonite and 
Barite increase across the perforations. The difference is small however, and so the risk may be 
equally low. The second is that be Halite saturation increases from S=0.87 to S=0.0.94 at 
Bottomhole. It remains sub-saturated, but this is a challenging question; is the measured 
concentration of Na+ and Cl- based on the reservoir composition, or is it possibly affected by salt 
buildup in the tubing? This question is beyond the scope of this course example, and will be taken 
up in a latter chapter. 

✓ Click on the Variables button –  

✓ Remove all the variables from the Y1-Axis 

✓ Expand the Phase Flow Properties category.  Add Volume – Liquid-1 to the Y1 Axis  

 

 
 

✓ Click OK to view the plot (click on View Plot button if necessary) 
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The water flow changes significantly from the bottom to the top of the well – condensation is occurring 
somewhere within the tubing. Were additional depth conditions made available, then the 
condensation process could be refined further.  
 

Summary 

This is an example of a well that produces condensed water. This condensed water represents ~75% 
of the total water flow. As a result, the water sample obtained is diluted, and certain assumptions are 
made so that we were able to compute scale risks during production.  The conclusion is that reservoir 
brine is close to NaCl saturation and supersaturated with Calcite, Aragonite, and Barite.   
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 – Oil Well with Gas 
Lift 

Overview 

This case is an oil well produced with the aid of gas lift. It is a two-zone production, with brine and 
oil produced at 2500m MD and a gas cap produced at 2450m MD. The gas lift valve (GLV) is about 
halfway up the well at 1200m MD. The process schematic is below. There are four inflow streams; 
brine, oil, gas cap gas, and lift gas. Calcite cementation is part of the rock matrix and this mineral is 
in equilibrium with the reservoir oil & brine.   

2500 m MD

2450 m MD

1200m MD 
GLV exit

Wellhead
Gas 

Separator
Oil 

Separator

Lift Gas

Gas Cap

Reservoir 
oil/brine

Oil to Sales

Brine to 
Disposal

Gas to Sales

Reservoir

Brine

Oil

Cementing Mineral
 (Calcite)

1250m MD 
before GLV

 

This chapter has seven tasks. The first four are data entry and use ScaleChem objects brine, gas, 
and oil analyses. Task five is the reservoir saturation calculation and task six is the facilities 
calculation to model production. The final task is to evaluate results and make any modifications as 
needed.  The first five tasks are similar to those used in previous chapters, which is expected, as the 
software is designed to work in this way.  

 

✓ Save and close any cases currently on the screen   
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Task 1 – Add the GLV Brine analysis 

 

✓ Select File > New and Save as Chapter 11 - Lift Gas Well 

✓ Click on Streams and change the name to Gas Lift Valve 

 

 

✓ Select Gas Lift Valve and go to Chemistry > Model Options… 

 

 

✓ Under the Databanks tab select the MSE-SRK (H3O+ ion) as the Thermodynamic Framework, 
and click OK. 

 

 

✓ Add a Brine Analysis  

✓ Label it GLV Brine  

✓ Enter the ions from the table below in the Data Entry grid  

 

GLV Brine Analysis 

Cations mg/l Anions mg/l Neutrals mg/l Measured Data 

Na+1 26500 Cl-1 43150 SiO2 26 Temperature (C) 15 

K+1 350 SO4-2 20 B(OH)3 60 Pressure (atm) 1 

Ca+2 800 C2H3O2-1 30   pH 7.2 

Mg+2 170     Alkalinity 140 

Sr+2 120     TDS, mg/L 42000 

Ba+2 60       

 

✓ After entering the data in the Data Entry tab, select the Show Non-zero Only option and keep 
the default balance option as Dominant Ion 

 

The screen should look like the image below 
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✓ Select the Reconcile (blue) tab and enter the Measured Data from the above table (15⁰C, 1 
atm, 7.2 pH, 140 mg HCO3/L alkalinity, and 42000 TDS) 

✓ Select the Measured pH and Alkalinity option  

 The Alkalinity (titration) End Point pH is set to 4.5. Keep this value 

 

✓ Calculate  
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Task 2 – Add the Gas Cap Analysis 

✓ Add a new Gas Analysis –   

✓ Label it Gas Cap –  

✓ Select the Expanded template –  

 

✓ Enter the following composition: 

Gas Cap Analysis Composition 

Formula Component name Mole % 

H2O Water 0 

CH4 Methane 90 

N2 Nitrogen 2.1 

CO2 Carbon dioxide 1.33 

C2H6 Ethane 2.37 

C3H8 Propane 1.25 

i-C4H10 Isobutane 0.46 

n-C4H10 n-Butane 0.59 

i-C5H12 Isopentane 0.32 

C5H12 n-Pentane 0.34 

C6H14 n-Hexane 0.44 

C7H16 n-Heptane 0.36 

C9H20 n-Nonane 0.11 

C10H22 n-Decane 0.09 

C11H24 n-Undecane 0.07 

C12H26 Dodecane 0.03 

C13H28 n-Tridecane 0.02 

C14H30 n-Tetradecane 0.02 

C15H32 n-Pentadecane 0.01 

C16H34 n-Hexadecane 0.01 

C6H6 Benzene 0.01 

C7H8 Toluene 0.02 

C8H10 Ethylbenzene 0.02 

C8H10 1,3-Dimethylbenzene 0.02 

C8H10 o-Xylene 0.01 

 

There is no water present in the gas, and it is reasonable to add it.  However, since the production 
has a high-water rate, the additional water will be negligible to the brine mass.  
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Gas Cap in Display Name view  
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Task 3 – Add the GLV Oil (Reservoir Oil) 

✓ Add an Oil Analysis –  

✓ Label it GLV Oil  

✓ Input the following data in the Combined tab; switch between Formula and Display view 

 

GLV Oil Analysis Composition 

Formula Component name Mole %  Formula Component name Mole % 

H2O Water 0 C18H38 n-Octadecane 1.29 

CH4 Methane 38.67 C19H40 n-Nonadecane 1.19 

C2H6 Ethane 3.38 C20H42 n-Eicosane 0.91 

C3H8 Propane 3.11 C21H44 Heneicosane 0.82 

i-C4H10 Isobutane 2.66 C22H46 Docosane 0.74 

n-C4H10 n-Butane 2.44 C23H48 Tricosane 0.67 

i-C5H12 Isopentane 2.02 C24H50 n-Tetracosane 0.57 

C5H12 n-Pentane 1.57 C25H52 Pentacosane 0.5 

C6H14 n-Hexane 3.24 N2 Nitrogen 1.5 

C7H16 n-Heptane 3.7 CO2 Carbon dioxide 1.19 

n-C8H18 n-Octane 2.87 C6H6 Benzene 0.08 

C9H20 n-Nonane 2.45 C7H8 Toluene 0.37 

C10H22 n-Decane 2.8 C8H10 Ethylbenzene 0.34 

C11H24 n-Undecane 2.63 C8H10 1,3-Dimethylbenzene 0.65 

C12H26 Dodecane 2.36 C8H10 o-Xylene 0.29 

C13H28 n-Tridecane 2.33    

C14H30 n-Tetradecane 1.86    

C15H32 n-Pentadecane 1.86 Pseudocomponent (next step) 

C16H34 n-Hexadecane 1.49 C30PLUS PseudoC30 6.15 

C17H36 n-Heptadecane 1.3  nBP=476 MW= 394   

 

✓ Select the Pseduocomponents tab  

✓ Type the Component name as C30PLUS then press <Enter> 

✓ Enter the Molecular Weight of 394 g/mole 

✓ Enter the Normal Boiling Point of 476 °C 

✓ Give it a Value of 6.15 mole% 

 

 

 

✓ Go back to the Combined tab and check if the Pseudocomponent registered  
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You will not use the reconcile step here either. Again, the brine mass is high relative to the oil, and 
therefore the small amount of H2O in the oil phase is small relative to the total brine mass. Not taking 
this step adds a small amount of error to the calculation, but this is less than 1%.  
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Task 4 – Add the Lift Gas Analysis 

Lift gas may exist as sales gas or come from a separate source. In this case, the lift gas is similar 
but not identical to the separator gas. This means that the lift gas is a mixture of production gases 
from the field. 

✓ Add a new Gas Analysis –  

✓  Label it Lift Gas  

✓ Select the Expanded template –  

✓ Enter the following  gas composition: 

 

Lift Gas Composition 

Formula Component Name Lift Gas 

H2O Water 0 

N2 Nitrogen 1.9 

CO2 Carbon dioxide 0.75 

CH4 Methane 81.35 

C2H6 Ethane 7.2 

C3H8 Propane 4.87 

i-C4H10 Isobutane 0.85 

n-C4H10 n-Butane 1.71 

i-C5H12 Isopentane 0.4 

C5H12 n-Pentane 0.21 

C6H14 n-Hexane 0.13 

 

✓ Check the Show Non-zero Only box  

 

 

This gas analysis is also missing the water content.  You will not use the H2O saturation option to 
calculate the amount. This step is being ignored purposely to illustrate that the water saturation 
option although improving mass balance, does not necessarily affect the final results, even though 
the water cut is 10 %v/v.  



OLI Studio: ScaleChem Basics – Oil Well with Gas Lift  11-9 

Task 5 – Add the GLV-Reservoir (Saturator) 

The oil and brine are at equilibrium in the reservoir. This equilibrium will be set using the Saturator 
object. You will set the saturator to equilibrate the gas and oil at reservoir conditions, and to saturate 
the mixture with calcite (the reservoir’s cement mineral). 

 

✓ Add a Saturator –  

✓ Label it GLV Reservoir  

✓ Enter Brine type, select GLV Brine, and 296 m3/day flow 

✓ Enter Oil type, select GLV Oil, and 1000 std m3/day in the next row 

✓ Enter the Reservoir Conditions of 137C and 170 atm 

 
 

✓ Select the Standard box in the Solid tab 

 

✓ Calculate  

✓ Select the Report tab  

✓ Go to the Phase Properties table and review the Liquid-1 volume (at std conditions)  

 

 

The input water rate is 296 m3/day. The computed rate (at standard conditions – no thermal 
expansion) is 294.29 m3/day, a 0.6% decrease.  Had the oil been saturated with water at reservoir 
conditions, this difference would have been eliminated. 

 

✓ Scroll down to the Pre and Post Scale Tendencies table 
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Barite is nearly saturated with a value of 0.96, and no excess solute is computed to precipitate. It is 
reasonable to consider saturating the fluid with barite; however, we will not saturate it since the focus 
on the next step is to develop the Facilities calculation to model the flow conditions. 

 

✓ Save the file  

 

Task 6a – Add the Well Production (Facilities) 

The last, and primary task of this chapter is to use the Facilities object to model production from the 
two reservoirs through the gas life up to the surface facilities. Since the flow dynamic is more 
complicated than the Scale Scenario can handle, the Facilities object is required. The image below 
is the process flow diagram.   

2500 m MD

2450 m MD

1200m MD 
GLV exit

Wellhead
Gas 

Separator
Oil 

Separator

Lift Gas

Gas Cap

Reservoir 
oil/brine

Oil to Sales

Brine to 
Disposal

Gas to Sales

Reservoir

Brine

Oil

Cementing Mineral
 (Calcite)

1250m MD 
before GLV

 

Flow Diagram of Well Production 
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Material enters the well at three locations; brine and oil enter at 2500m MD, the gas cap gas enters 
at 2450m MD and lift gas is enters at 1200m MD.  Material also exits at three locations, Gas to Sales, 
Oil Separator and Brine to disposal. 

   

The specifications for the flow diagram is provided in the table below.  It is divided into three sections, 
the conditions, inflows, and additional specifications (notes).  You will enter the information in that 
order. 

 

Descriptions of GLV Production Nodes in Facilities Calculation 

Node Conditions Inflows notes 

Node Node Name T (°C) 
P 

(bar) 
Type(s) Inlet Name(s) Flow(s)  

1 Reservoir 137 170 Whole Fluid GLV Reservoir Automatic  

2 2500m MD 137 170 Whole Fluid from Reservoir Automatic  

3 2450m MD 135 152 
Whole fluid from 2500m MD Calculated 

 
Gas Gas Cap 5 std E3m3/d 

4 
1250m MD 
before GLV 

115 120 Whole fluid from 2450m MD Calculated  

5 
1200m MD 
GLV exit 

101 105 
Whole fluid from 

1250m MD 
before GLV 

Calculated Drop 
solids 

Gas Lift Gas 30 std E3m3/d 

6 Wellhead  80 70 Whole fluid from 
1200m MD 
GLV exit 

Calculated  

7 Gas Separator 40 30 Whole fluid from Wellhead Calculated Drop 
solids 

8 Oil Separator 70 15 Oil from Gas Separator Calculated Drop 
solids 

9 Gas to Sales 15 1 
Gas from Gas Separator Calculated 

 
Gas from Oil Separator Calculated 

10 
Brine to 
Disposal 

15 1 
Brine from Gas Separator Calculated 

 
Brine from Oil Separator Calculated 

 

✓ Add a Facilities object –   

✓ Label it GLV Production 

✓ Add ten nodes total (press the Add button 9 times) –  

✓ Label each node using the table above 

✓ Go to the Conditions (blue) tab to enter the Temperature and Pressure conditions at each 
location 

 

The screen should look like the image below. 
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✓ Go back to the Inflow Specs tab and start connecting the inflows, according to the table above 

 

The oil and brine are at equilibrium in the reservoir (2500m MD). By comparison, the gas cap is not 
in contact with the water and so it enters at a different depth, and a different node (2450m MD). The 
screen should look like the image below when all nodes are added and connected with their 
respective inflows. 

 

 

 Note, that three nodes contain two inflows, for example the entry for the 2450 m MD node 

looks like the image below. 

 

Inflows for Node 3, 2450m MD 

✓ Select the Solid tab and check the Standard Solids box  
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✓ Save the file  

✓ Calculate 

 

Task 6b – Studying the Facilities plot/report and making modifications to the 
calculations 

The focus of this section is to review plot. The items to be reviewed include: 

 

1. Surface flow rates – Do the calculations match the volumes measured for each phase? 

2. Brine Analysis – Do the calculated concentrations at the sampling location match the values 
measured in the actual sample? 

 

✓ Select the Plot tab 

 

The default plot is the Dominant Pre-Scaling Tendencies vs Locations 

 

 

Notice that Barite is predicted to be at near saturation at reservoir conditions. As the fluid moves to 
the different facilities locations the risk of scaling increases. 
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✓ Press the Variables button  

✓ Remove the Variables in the Y1 axis 

✓ Expand the Phase Flow Properties category 

 

Let’s find out if the calculations match the volumes measured for each phase 

 

✓ Select the following variables:  

o Volume, Std. Conditions – Vapor 

o Volume, Std. Conditions –Liquid-2  

o Volume – Liquid-1  

 

 

 

✓ Press OK then select the View Data button 

 

 

Now, let’s check if the calculated concentrations at the sampling location match the values measured 
in the actual sample. 

 

✓ Select the Variables button and remove all the variables from the Y1 Axis  

✓ Expand MBG Totals – Liquid-1 and double-click Ba(+2) Liq 1,  Ca+2 Liq 1, Cl(-1) Liq 1, and 
S(+6) Liq 1 

 

✓ Press OK and view the table 



OLI Studio: ScaleChem Basics – Oil Well with Gas Lift  11-15 

 

 

Summary 

This chapter introduced another approach to using the Facilities object.  
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 –Calculating Alkalinity 

Overview 

In this chapter you will learn: 

• How to calculate acid:anion ratios at varying ionic strengths 

• Use the Mixing Water calculation as a pH titration apparatus 

• Understand how weak acid chemistry affects alkalinity 

• Compare true bicarbonate and carbonate concentrations to carbonate alkalinity 

 

Investigating the Components that Create Alkalinity 

The alkalinity measurement is used to compute carbonate scale tendencies and pH buffer capacity. 
Bicarbonate, and to a lesser degree, borates, organic acids and bisulfides, provide alkalinity to 
produced water. Therefore, this chapter is an introduction to quantifying alkalinity beyond the 
standard contributions from 𝐻𝐶𝑂3

−, 𝐶𝑂3
−2 and 𝑂𝐻−.  

 

Carbonate Alkalinity Contributions 

The Standard Methods for the Examination of Water and Wastewater codified the measurements to 
determine alkalinity. In its second edition (1912), the book linked alkalinity and total hardness to 
CaCO3 scale (an interesting side note, in the year of publication, olive oil-derived castile soap was 
used to measure total water hardness instead of inductively coupled plasma spectrometry). 
Measurements related to Lacmoid, Erythrosine, Methyl orange, silver nitrate and phenolphthalein, 
were all designed to measure carbonate and hydroxide alkalinity. The contribution of non-carbonate 
and non-hydroxide buffers, like organic acids, do not have supporting text. Oilfield water analyses 
continue to use the original experimental design with the same endpoint, despite the measurement 
does not capture the produced water species complexity. 

Alkalinity equations are a series of chemical reactions with measurable endpoints, described below: 

𝐻𝐶𝑂3
−2 + 𝐻+ = 𝐶𝑂2 + 𝐻2𝑂  𝑐𝑜𝑛𝑠𝑖𝑑𝑒𝑟𝑑 𝑐𝑜𝑚𝑝𝑙𝑒𝑡𝑒 𝑏𝑦 𝑝𝐻 < 4.5 (25°𝐶) 

𝐶𝑂3
−2 + 𝐻+ = 𝐻𝐶𝑂3

−  𝑐𝑜𝑛𝑠𝑖𝑑𝑒𝑟𝑑 𝑐𝑜𝑚𝑝𝑙𝑒𝑡𝑒 𝑏𝑦 𝑝𝐻 < 8.5 (25°𝐶) 

𝑂𝐻− + 𝐻+ = 𝐻2𝑂 𝑐𝑜𝑛𝑠𝑖𝑑𝑒𝑟𝑑 𝑐𝑜𝑚𝑝𝑙𝑒𝑡𝑒 𝑏𝑦 𝑝𝐻 < 10 (25°𝐶) 
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Thus, a simple definition for carbonate alkalinity is: 

𝐶𝑎𝑟𝑏𝑜𝑛𝑎𝑡𝑒 𝐴𝑙𝑘𝑎𝑙𝑖𝑛𝑖𝑡𝑦 = 𝑇𝑜𝑡𝑎𝑙 𝐻+𝑟𝑒𝑞𝑢𝑖𝑟𝑒𝑑 𝑡𝑜 𝑐𝑜𝑛𝑣𝑒𝑟𝑡 𝑎𝑙𝑙 𝐶𝑂3
−2, 𝐻𝐶𝑂3

−, 𝑎𝑛𝑑 𝑂𝐻−𝑡𝑜 𝐶𝑂2 

= 𝐻+ (𝑓𝑟𝑜𝑚 𝐶𝑂3
−2) + 𝐻+ (𝑓𝑟𝑜𝑚 𝐻𝐶𝑂3

− 𝑎𝑛𝑑 𝑛𝑒𝑢𝑡𝑟𝑎𝑙𝑖𝑧𝑒𝑑 𝐶𝑂3
−2) + 𝐻+ (𝑓𝑟𝑜𝑚 𝑂𝐻−)

= 𝑡𝑜𝑡𝑎𝑙 𝑎𝑐𝑖𝑑 𝑎𝑑𝑑𝑒𝑑 𝑡𝑜 𝑏𝑟𝑖𝑛𝑔 𝑡ℎ𝑒 𝑝𝐻 𝑡𝑜 < 4.5 

= 2𝐶𝑂3
−2 + 𝐻𝐶𝑂3

− + 𝑂𝐻− 

 

Lastly, a mass balance equation for carbonate: 

𝐶𝑎𝑟𝑏𝑜𝑛𝑎𝑡𝑒𝑇𝑜𝑡𝑎𝑙 = 𝐻𝐶𝑂3
− + 𝐶𝑂3

−2 

 

A Bjerrum plot, in which carbonate concentration is fixed, shows the relative concentration of each 
species as functions of pH (also shown is the relative OH- concentration): 

 

The calculations provide measurable hydroxide, carbonate and bicarbonate concentrations at a 
relative pH: free hydroxide (OH-) exists above 10 pH; carbonate exists above 8.5 pH; and 
bicarbonate exists between 4.5 and 8.5 pH. 

An alkalinity titration procedure is as follows:  

1. Start with a known sample volume 

2. Add two indicators - the first activates at 8.5 pH or higher and the second is active below 4.5 pH 

3. Titrate the sample with a strong acid of known composition  
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When the first indicator deactivates (the pH drops below 8.5), the amount of titrant added is the 
carbonate alkalinity and hydroxide alkalinity point. The following equation converts the acid volume 
to the carbonate alkalinity. 

𝐶𝑂3
− 𝐴𝑙𝑘 (

𝑚𝑔

𝐿
)  𝑎𝑠 𝐻𝐶𝑂3

−

= 𝐴𝑐𝑖𝑑 𝑣𝑜𝑙𝑢𝑚𝑒 𝑢𝑠𝑒𝑑 𝑡𝑜 8.5 𝑝𝐻 (𝐿) × 𝐴𝑐𝑖𝑑 𝐶𝑜𝑛𝑐. (
𝑚𝑜𝑙𝑒𝑠

𝐿
) × 61020 (

𝑚𝑔 𝐻𝐶𝑂3
−

𝑚𝑜𝑙𝑒
)

×
1

𝑆𝑎𝑚𝑝𝑙𝑒 𝑉𝑜𝑙 (𝐿)
 

 

4. The sample is titrated further until it until the second indicator appears (pH<4.5).  This is the 
bicarbonate alkalinity endpoint. This information is used as follows: 

𝐻𝐶𝑂3
− 𝐴𝑙𝑘 (

𝑚𝑔

𝐿
)  𝑎𝑠 𝐻𝐶𝑂3

−

=  𝑉𝑜𝑙 𝐴𝑐𝑖𝑑 𝑓𝑜𝑟 𝐵𝑖𝑐𝑎𝑟𝑏𝑜𝑛𝑎𝑡𝑒 𝐴𝑙𝑘 𝑇𝑖𝑡𝑟𝑎𝑡𝑖𝑜𝑛 (𝐿) × 𝐴𝑐𝑖𝑑 𝐶𝑜𝑛𝑐. (
𝑚𝑜𝑙𝑒𝑠

𝐿
)

× 61020 (
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙𝑒
) ×

1

𝑆𝑎𝑚𝑝𝑙𝑒 𝑉𝑜𝑙 (𝐿)
 

 

The two titrations combine to calculate the total alkalinity 

𝑇𝑜𝑡𝑎𝑙 𝐴𝑙𝑘 (
𝑚𝑔

𝐿
)  𝑎𝑠 𝐻𝐶𝑂3

−

= 𝑉𝑜𝑙 𝐴𝑐𝑖𝑑 𝑓𝑜𝑟 𝐶𝑎𝑟𝑏𝑜𝑛𝑎𝑡𝑒 𝐴𝑙𝑘 𝑇𝑖𝑡𝑟𝑎𝑡𝑖𝑜𝑛 (𝐿)

+  𝑉𝑜𝑙 𝐴𝑐𝑖𝑑 𝑓𝑜𝑟 𝐵𝑖𝑎𝑟𝑏𝑜𝑛𝑎𝑡𝑒 𝐴𝑙𝑘 𝑇𝑖𝑡𝑟𝑎𝑡𝑖𝑜𝑛 (𝐿) × 𝐴𝑐𝑖𝑑 𝐶𝑜𝑛𝑐. (
𝑚𝑜𝑙𝑒𝑠

𝐿
)

× 61020 (
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙𝑒
) ×

1

𝑆𝑎𝑚𝑝𝑙𝑒 𝑉𝑜𝑙 (L)
 

 

𝑂𝐻−𝐴𝑙𝑘 (
𝑚𝑔

𝐿
)  𝑎𝑠 𝐻𝐶𝑂3

− = 𝐶𝑂3
− 𝐴𝑙𝑘 (

𝑚𝑔

𝐿
) − 𝐻𝐶𝑂3

− 𝐴𝑙𝑘 (
𝑚𝑔

𝐿
) 

 

5. In the absence of carbonates or in addition to carbonate, the OH- alkalinity can also be 
determined from the difference between the carbonate and bicarbonate alkalinity and is only 
relevant above 9.5 or 10pH (OH->10-4.5 M or ~0.5ppm).  

𝐴𝑙𝑘𝑂𝐻 = 2 ∗ 𝐴𝑙𝑘8.5𝑝𝐻 𝐸𝑃 − 𝐴𝑙𝑘4.5𝑝𝐻 𝐸𝑃 

If the value is negative, then there is no hydroxide alkalinity.  Hydroxide alkalinity is not common in 
production waters because the pH is never that high. It is present in drilling and alkaline injection 
fluids.  
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Problem Statement  

Oilfield waters do not conform chemically, to the fresh water used in the original alkalinity method. 
Organic acids, borates, phosphates, sulfides and other proton-accepting species produce alkalinity. 
Consequently, the standard alkalinity titration cannot be used to measure the bicarbonate/carbonate 
concentration. We will evaluate this in the following examples.  

Task 1: Quantifying Alkalinity of Certain Anions 

You will compute the alkalinity of 100 mg/L of the following anions: HCO3
-, CO3

-2, OH-, CH3CO2
-, 

B(OH)4
-, SO4

-2, Cl- and HS. The counter-ion will be sodium making the system basic. There will be 
no additional salt (salinity) added the first set of calculations. This will allow you to quantify alkalinity 
at near-ideal activities. You will calculate a second time in the presence of 1M NaCl. You will 
conclude this section by producing a quantitative table showing the contribution to alkalinity as a 
function of species and salinity.  

We will be using C and atm units for Temperature and Pressure so please adjust accordingly.  

✓ Create a new file called “Alkalinity”  

✓ Add a new brine analysis  

✓ Rename it Alkalinity 

 

Bicarbonate 

✓ Select the Design tab  

✓ Find HCO3-1 in the Anions grid and give it a value of 100 mg/L 

✓ Check the Non-zero only box 

 

 

 

✓ Select the Reconcile tab 

✓ Leave the default reconciliation option (Concentration Data Only) 

✓ Click calculate and document the pH and alkalinity 
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The calculated pH is 8.27. The calculated alkalinity is 100.7 mg/L and is entirely the bicarbonate 
alkalinity. The 0.7 mg/L addition to the alkalinity value is due to the pH endpoint and minor activity 
coefficient effects.  

The next three steps will make it easier for us to perform titrations later. Alternatively, we can continue 
working in the same Alkalinity file and replace the anions as we go along. Subsequent instructions 
will be applicable for both approaches.  

✓ In the Navigator pane, right-mouse click Alkalinity and press copy 

  

✓ Right-mouse click the Streams icon, then select paste. Repeat this 7 times, to create a total of 8 
objects in the navigator panel. 

 

The software designates the new streams as Alkalinity -1, Alkalinity-2, and so on.  

✓ Rename the objects so that the anion they contain will be easily identifiable: Alkalinity-
Bicarbonate, Alkalinity-Carbonate, Alkalinity-Hydroxide, Alkalinity-Acetate, Alkalinity-Borate, 
Alkalinity-Sulfate, Alkalinity-Chloride, and Alkalinity-Bisulfide  
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Carbonate 

✓ Select the Alkalinity-Carbonate brine analysis stream  

✓ Remove the 100 mg/L HCO3-1 and add 100 mg/L CO3-2  

✓ Check the Non-zero only box 

 

 

 You can either type in CO3-2 in an empty cell, or select the Expanded Template to locate it in 
the Anion grid.  

✓ Select the Reconcile tab and recalculate  

 

The alkalinity is 204.1 mg/L as 𝐻𝐶𝑂3
− twice the 𝐶𝑂3

−2 concentration added, and is consistent with the 

above equation. The 𝐻𝐶𝑂3
− formula weight is 61.02 g/mole and 𝐶𝑂3

−2 is 60.01 g/mole – a mole ratio 

of 1.7%. Two factors contribute to the alkalinity increase. The first is that 𝐶𝑂3
−2 accepts two 𝐻+ ions 

one above 8.5 pH and one above 4.5 pH. The second is that 1.7% additional moles of carbonate are 
added because of the weight difference. Thus, the theoretical alkalinity of 100 mg/L alkalinity as 
𝐻𝐶𝑂3

− *2 * 1.7% = 203.4 mg/L alkalinity as 𝐻𝐶𝑂3
−. The computed value is 204.1. 

Note the slight bias forming in the results. Instead of exactly 203.4 mg/L, the value is 0.70 mg/L 
higher. This difference is due to non-ideal effects and the precise pH choice. The equations provided 
above are for ideal conditions. However, we are well aware that there are non-ideal effects that must 
be considered.  
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Hydroxide 

✓ Select the Alkalinity-Hydroxide brine analysis stream  

✓ Remove the 100 mg/L HCO3-1 and add 100 mg/L OH-  

 

✓ Select the Reconcile tab and recalculate  

 

The computed alkalinity is 361.3 mg/L as HCO3
-1. The formula weight of 𝑂𝐻− is 17.01 g/mole 

compared with 61.02 g/mole for 𝐻𝐶𝑂3
−1, so 3.587 times more moles of 𝑂𝐻− is added compared with 

𝐻𝐶𝑂3
−.  

Therefore, 

61020

17010
× 100

𝑚𝑔 𝑎𝑠 𝐻𝐶𝑂3
−

𝐿
= 358.7

𝑚𝑔 𝑎𝑠 𝐻𝐶𝑂3
−

𝐿
 

Complete 𝑂𝐻− neutralization actually happens at about 10 pH, not 4.5 pH, which is the experimental 
endpoint. Observing the neutralization effect requires a titration curve.  
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Task 2: Non-Carbonate Alkalinity Contributions 

We will see complications arising when other species contribute to alkalinity because they affect the 
direct use of the alkalinity value in the carbonate/scale tendency equation. Contributing species 
include borate, phosphate, formate, acetate, propanate, bisulfide, and any anion that will accept H+ 
ion above 4.5 pH.  

 

Acetate 

✓ Select the Alkalinity-Acetate brine analysis stream  

✓ Zero out any existing concentrations and add 100 mg/L acetate C2H3O2-1 

 

✓ Select the Reconcile tab and recalculate  

 

The computed alkalinity is 68.9 
𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

−. The acetate formula weight is 59.05 g/mole, close to 

𝐻𝐶𝑂3
− (61.02 g/mole). So, if all the acetate contributes to alkalinity, then 100 mg/L acetate should be 

close to that for 100 mg/L 𝐻𝐶𝑂3
− as shown in the following equation:  

61020 
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙

59050 
𝑚𝑔 𝐴𝑐𝑒𝑡𝑎𝑡𝑒−

𝑚𝑜𝑙

× 100
𝑚𝑔 𝐴𝑐𝑒𝑡𝑎𝑡𝑒−

𝐿
= 103.3

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− 

The theoretical alkalinity contributed by acetate is 103.3 
𝑚𝑔

𝑙
𝑎𝑠 𝐻𝐶𝑂3

−. This means that 68.95
103.3⁄ =

67% of the acetate ion accepted an 𝐻+ at 4.5 pH (33% remained as the 𝐶2𝐻3𝑂2
− ion). Acetate 

concentrations therefore have significant impact on total alkalinity.  

 

Borate 

✓ Select the Alkalinity-Borate brine analysis stream 

✓ Remove any existing concentrations and add 100 mg/L borate, B(OH)4-1 
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✓ Select the Reconcile tab and recalculate  

 

The borate contribution is 79.52 
𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− for 100 mg/L added. If 100% borate contributed to 

alkalinity the maximum value would be: 

61020 
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙

78835 
𝑚𝑔 𝐵(𝑂𝐻)4

−

𝑚𝑜𝑙

× 100
𝑚𝑔 𝐵(𝑂𝐻)4

−

𝐿
= 77.39

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− 

The theoretical alkalinity is slightly lower than the computed amount (we will investigate this next). 
Thus, borate appears to be significant contributor to alkalinity. However, the pH is high, 10.12. Borate 
is generally neutralized to boric acid by ~7 pH. Consequently, only a fraction of the total boron in 
produced water is in anion form. Most is found in the acidic form 𝐻3𝐵𝑂3. 

 

Sulfate 

✓ Select the Alkalinity-Sulfate brine analysis stream  

✓ Remove any existing concentrations and add 100 mg/L sulfate (SO4
−2)  

 

✓ Select the Reconcile tab and recalculate  
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The sulfate contribution is 2.2 mg/L as HCO3
- for 100 mg/L SO4

-2 added. If 100% sulfate contributed 
to alkalinity the maximum value would be: 

61020 
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙

96060 
𝑚𝑔 𝑆𝑂4

−2

𝑚𝑜𝑙

× 100
𝑚𝑔 𝑆𝑂4

−2

𝐿
= 63.52

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− 

Sulfate has negligible effects on alkalinity. This is not surprising, since 𝑆𝑂4
−2 is a salt of an acidic 

anion 𝐻𝑆𝑂4
−. To reach the theoretical contribution of 63.52 

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

−, the endpoint pH would be 

near 0.3. 

 

Chloride 

✓ Select the Alkalinity-Chloride brine analysis stream 

✓ Remove any existing concentration and add 100 mg/L chloride (Cl-)  

 

✓ Select the Reconcile tab and recalculate  

 

The chloride contribution is 2.04 mg/L as bicarbonate for 100 mg/L Cl- added. If 100% chloride 
contributed to alkalinity the maximum value would be: 

61020 
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙

35453 
𝑚𝑔 𝐶𝑙−

𝑚𝑜𝑙

× 100
𝑚𝑔 𝐶𝑙−

𝐿
= 172.1

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− 

Chloride has negligible effects on alkalinity for the same reason as sulfate. Both are conjugate bases 

of strong acids. To reach the theoretical contribution of 172.1 
𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

−, the endpoint pH would be 

about 5. 

 

Bisulfide 

✓ Select the Alkalinity-Bisulfide brine analysis stream 

✓ Remove any existing concentration and add 100 mg/L bisulfide (HS−)  
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✓ Select the Reconcile tab and recalculate  

 

The calculated bisulfide contribution is 186.13 
𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− for 100 mg/L added. If 100% sulfate 

contributed to alkalinity the maximum value would be: 

61020 
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙

33070 
𝑚𝑔 𝐻𝑆−

𝑚𝑜𝑙

× 100
𝑚𝑔 𝐻𝑆−

𝐿
= 184.5

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− 

The theoretical bisulfide ion alkalinity is 184.5 
𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

−. It has a significant impact on alkalinity. 

Bisulfide concentrations however are generally low in produced water. Therefore, the absolute 
effects are small. 

A summary of all the calculation results are shown in the table below. 

100 mg/L of the following ion Initial pH Alkalinity as mg/L HCO3 

HCO3- 8.27 100.66 

CO3-2 10.64 204.1 

OH- 11.73 361.29 

Acetate- 7.99 68.89 

B(OH)4- 10.13 79.52 

SO4-2 7.01 2.21 

Cl- 6.99 2.04 

HS- 9.19 186.13 
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Task 3: Alkalinity Titration Curves  

The alkalinity endpoint provides a snapshot of fluid chemistry. A complete titration curve shows the 
system behavior across the pH profile and therefore the buffering region of different bases. In this 
section, we will create alkalinity titration curves for 100 mg/L of HCO3

-, CO3
-2, OH-, Acetate-, and 

B(OH)4
-. 

The first two sections below are alternatives. Clients can either use OLI Studio: ScaleChem objects 
to create the 1N HCL reagent or use the OLI Studio: Stream Analyzer module.  

 

Task 3-1 Create the 1N HCl Reagent with OLI Studio: ScaleChem 

✓ Add a new brine analysis  

✓ Name it 1N HCl-1 

✓ Type HCL in the neutrals section with 36,453 mg/L 

✓ Select the show non-zero box  

 

✓ Select the Reconcile tab then calculate  

 

It should not be surprising that the reagent pH is almost zero. HCl is a strong acid, and thus the H-
Cl bond is weak, resulting in near complete dissociation. Thus, there is 1 mole H+ in solution or zero 
pH. 

✓ Save the file 

 

Task 3-2 Create the 1N HCl Reagent with OLI Studio: Stream Analyzer  

✓ Select the Global Streams icon in the Navigator pane  

 

✓ Double-click the Add Stream icon in the Actions pane  
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✓ Press the <F2> key and change the name to 1N HCl-2 

✓ Select the Units Manager icon then use the Quicklist button to pick Metric, concentration 

 

✓ Press OK then enter HCl as an inflow with a concentration 36,453 mg/L 

 

Task 3-3 Create an Alkalinity Titration 

Once we complete either of the above methods for creating the HCl reagent stream, we can proceed 
with the following tasks.  

✓ Add a Mixing Water object    

✓ Rename it Alkalinity Titrator 

✓ Change the Brine Volumes to ml (per day) by clicking a blue-colored unit and opening the Units 
Manager 

    

✓ Select the bottom right corner of the Name cell and pick 1N HCL-1 as the first brine  

 

Note: Remember that first brine is the stream that the Mixer will adjust. 

 

✓ Set the total volume to 1000 mL/day 

 

The 1L volume is the total liquid volume (sum of 1st and 2nd brine). In this case, the 1L will be primarily 
the alkalinity liquid that we will enter next. The 1N HCl reagent will be added to the Alkalinity liquid, 
but its volume will be relatively small. It is an imperfect example, but it serves to show another 
application of the Mixing tool. The actual flow rate is unimportant, but for realism, we will use a 
volume similar to laboratory conditions.  
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Task 3-4 Bicarbonate Titration Curve 

✓ Select the bottom right corner of the Name cell in the Second Brine row and pick the Alkalinity-
Bicarbonate (the original Alkalinity brine) as the second brine 

 

✓ Go to the Conditions tab 

✓ Change the type from Ratio to Flow 

 

✓ Type 2 in the first column and first row then press tab and type 0 in the second row   

 

✓ Change the Auto Steps amount to 20 then select the Auto Step button  

 

The software will add the HCl at 0.1 mL increments up to 2 mL. It will also remove 0.1 mL of Alkalinity-
HCO3 volume at each step to maintain the 1000 mL volume. Consequently, the titration we are doing 
is not 100% correct. In an actual titration, the sample fluid volume is fixed at 100 mL. Fortunately, 
the HCl reagent is concentrated, and the volume added is small. This limits the displacement error 
to 0.2%  
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✓ Press the Calculate button  

✓ Select the Plot tab and then select the Variables button  

✓ Remove all existing plot variables in the Y1 Axis by highlight the Y1 axis header then select the 
<< arrow button  

 

✓ Expand the Aqueous category and add HCO3-1 to the Y1 axis  

✓ Expand the Additional Stream Parameters category and add pH-Aqueous to the Y2 axis  

 

✓ Press OK and view the plot 

 

The pH curve is the typical bicarbonate-buffering curve. The slope of the curve is shallow between 
pH 7 and 5.5, where bicarbonate buffering is strong. Below 5.5 pH, the curve drops sharply and has 
its steepest slope at about 4.5 pH. 
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✓ Click the View Data button 

  

✓ Copy the data to a spreadsheet program by holding down the left arrow, highlighting all the points 
and pressing <Ctrl+C>. 

✓ Click on the View Plot button to show the plot again  

 

For the following titrations, we can either add a new Mixing Water object or work from the existing 
object. The instructions below assume the latter.  

 

Task 3-5 Carbonate Titration Curve 

✓ Return to the Design | Inlets screen 

✓ Replace the second brine with the Alkalinity – Carbonate stream  

 

✓ Select the Conditions tab and change the 1N HCl flow from 2 ml to 4 ml (top cell) 

 

We will need twice as much acid to titrate the CO3
-2 
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✓ Make sure Auto steps are set at 20 and click on the Auto Step button then click on the calculate 
button 

 

✓ Select the Plot tab then select the Variables button 

✓ Add CO3-2 from the Aqueous categories to the Y1 Axis  

 

✓ Press OK and view the Plot 

 

✓ Click on the View Data button then copy data to a spreadsheet program 

✓ Click on the View Plot button to show the plot again  

✓ Save the file   
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Task 3-6 Hydroxide Titration Curve 

✓ Return to the Design | Inlets tabs and replace the Carbonate stream with Hydroxide  

 

✓ Select the Conditions, tab then overwrite the first cell with 7 ml  

✓ Press the Auto Step button and then click the calculate button 

 

✓ Select the Plot tab then select the Variables button 

✓ Remove the carbonates by double clicking on them 

✓ Add OH- from the Aqueous section to the Y1 axis, and add pH in the Y2 axis 

 

✓ Select the View Data button and copy the data to a spreadsheet 

✓ Click on the View Plot button to show the plot again  

✓ Save the file   
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Task 3-7 Acetate Titration Curve 

✓ Repeat the same procedure for Acetate 

 

✓ Select the Conditions, tab then overwrite the first cell with 2 ml  

✓ Reset the Auto Steps to 20 

✓ Press calculate then plot pH on the Y2 Axis and acetate ion (C2H3O2-1)to the Y1 axis  

 

✓ Save the file  

✓ Click on the View Data button then copy the data to a spreadsheet program 
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Task 3-8 Borate Titration Curve 

✓ Redo the calculation for Borates 

✓ Decide upon which species are important to plot 

 

✓ Click on the View Data button and copy data to a spreadsheet program 

✓ Save the file   
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Task 3-9 Sulfate Titration Curve 

✓ Repeat for Sulfate 

 

The sulfate titration calculation was taken well beyond the alkalinity endpoint in order to show the 
equilibrium between the SO4

-2 and HSO4
- species. At ~2 pH, SO4

-2 and HSO4
-have roughly the same 

concentration: this is a sulfate buffering region.  

✓ Click on the View Data button and copy the data to a spreadsheet program 

✓ Save the file   
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Task 3-10 Interpreting the Titration Data 

✓ Move to the spreadsheet  

✓ Plot the pH vs. HCl  

 

This plot shows the buffering (pH) regions and the total buffering capacity of each weak acid. The 
highest buffering capacity, though not relevant to produced waters, is OH-. It’s relatively low 
molecular weight (17 g/mol) results in more buffering per concentration (all are fixed at 100 mg/l). Its 
buffering region ends at about 10.5 pH (extent of shallow slope). At this pH virtually all the OH is 
consumed by the HCl titrant. Consequently, at typical produced water pH (between 5 and 8) no OH- 
buffering occurs.   
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✓ Plot the species concentrations vs. pH 

 

The plot above shows the concentration impact in greater detail. It represents the concentration of 
free ion vs. pH for the different buffers. The red vertical line to the far left is the pH titration end point. 
The shaded vertical section to the right is the typical produced water pH as measured in the 
laboratory. From this diagram we can see that very little OH- exists in produced water between 7 and 
8 pH. 

The carbonate ion is dibasic (accepts two H+) and therefore has two buffering regions and endpoints. 
The first buffering zone exists from 10.7 to 9 pH, and the sharp pH drop reflects CO3

-2 depletion from 
solution. Few produced waters have pH above 8, and therefore CO3

-2 alkalinity is rarely observed. 
The second buffering region of CO3

-2 is associated with protonating HCO3
-, and this second zone 

parallels exactly the 100 m/l HCO3
-1 titration curve. This second curve is the main alkalinity 

component in produced waters. Its existence is due to the continuous production of CaCO3(s) in 
seawater. 

The acetate buffering zone is between about 5.7 and 3.5 (end of curve). If the titration were extended, 
then the inflection point ~2.7 pH would have been observed. This buffering zone straddles the 
alkalinity endpoint, which is why it creates complications when measuring total alkalinity without an 
organic acid content. Organic acids are products of organics/kerogen catagenesis, which creates 
the fossil fuel. Therefore, it is commonly observed in produced waters. Lastly, the borates buffering 
region is between 10 and 8 pH with an end point at about 6 pH. Borates exist at pH’s higher than the 
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typical produced water, but when borate concentrations are high and the laboratory measured pH 
approaches or exceeds 8, then this base will affect total alkalinity. Borates exist in seawater and 
deposit in the interstices of sediments. They are also fairly soluble (like Cl and Na) and are generally 
found in produced waters.  

The table below contains the pH and concentration data from the calculations we ran and plotted 
above. The shaded cells represent the regions in the titration curves that would contribute to a 
produced water alkalinity. At the bottom of the table is a % range value. This value represents the 
fraction of the species concentration that would contribute to the alkalinity. 

HCO3-1 CO3-2 OH- Acetate-1 BOH4-1 SO4-2 HS- 

pH mg/l pH mg/l pH mg/l pH mg/l pH mg/l pH mg/l pH mg/l 

3.5 0 3.2 0 2.8 0 3.4 4 3.2 0 2.8 87 3.0 0 

3.6 0 3.3 0 2.9 0 3.5 6 3.2 0 2.8 88 3.1 0 

3.8 0 3.6 0 3.1 0 3.7 7 3.3 0 2.8 88 3.3 0 

4.1 1 4.1 0 3.3 0 3.8 10 3.4 0 2.8 89 3.4 0 

4.8 3 5.2 0 3.8 0 3.9 13 3.5 0 2.9 89 3.8 0 

5.3 9 5.7 0 10.3 4 4.1 17 3.7 0 2.9 90 4.9 1 

5.6 15 6.0 0 10.7 10 4.2 21 3.9 0 2.9 90 5.9 7 

5.7 21 6.2 0 11.0 17 4.3 26 4.5 0 2.9 91 6.2 14 

5.9 27 6.4 0 11.1 23 4.4 31 8.0 5 3.0 91 6.4 20 

6.0 33 6.6 0 11.2 29 4.5 37 8.4 13 3.0 92 6.5 27 

6.1 39 6.9 0 11.3 36 4.6 42 8.6 21 3.1 92 6.7 34 

6.2 45 7.4 0 11.4 42 4.7 48 8.8 28 3.1 93 6.8 40 

6.3 51 8.8 4 11.4 49 4.8 54 9.0 36 3.2 94 6.9 47 

6.4 57 9.5 14 11.5 55 4.9 59 9.1 44 3.2 94 7.0 54 

6.6 63 9.7 24 11.5 62 5.0 65 9.2 51 3.3 95 7.1 60 

6.7 69 10.0 34 11.6 68 5.2 71 9.4 58 3.4 95 7.3 67 

6.8 75 10.1 43 11.6 74 5.3 77 9.5 66 3.5 96 7.4 73 

7.0 81 10.3 51 11.6 81 5.4 82 9.6 73 3.6 97 7.6 80 

7.2 87 10.4 59 11.7 87 5.6 88 9.8 79 3.8 97 7.8 87 

7.5 93 10.5 66 11.7 94 6.0 94 10.0 84 4.1 98 8.1 93 

8.3 98 10.6 71 11.7 100 8.0 100 10.1 89 7.0 99 9.2 99 
              

% in range 93  0  0  63  5  1  79 

Consider the following with this table: Anions are now being measured using ion chromatography. 
How does the alkalinity value measured relate to this ion chromatography measured ions?  
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Task 4: Effects of Temperature and Salinity on Carbonate Alkalinity 

✓ Return to the original Alkalinity (or Alkalinity-Bicarbonate) brine 

✓ Copy and paste it to create a new one 

✓ Rename it Alkalinity-Bicarbonate-NaCl 

✓ Add 23000 mg/l Na+ and 35453 mg/l Cl- 

 

✓ Return to the Alkalinity Titrator object and select the Inlets tab 

✓ Change the second brine to the new Alkalinity-Bicarbonate-NaCl brine 

✓ Set the Max HCl to 2ml and press the Auto Steps 

✓ Calculate, Select the Plot tab, then the Variables button  

✓ Remove all the variables from the Y1 and Y2 axes 

✓ Add HCO3
- from the Aqueous category to the Y1 Axis and pH from the Additional Stream 

Parameters section in the Y2 Axis  

 

✓ Copy the data to the Spreadsheet and add this plot with the original HCO3
- titration plot  

✓ Click on the Alkalinity Titration’s Inlets tab and change the temperature to 75C  

✓ Calculate 
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✓ Plot the pH vs. HCl for the three 100 mg/l HCO3
- calculations (25C, 25C & 1N NaCl, and 75C & 

1N NaCl). 

 

Consider the following when viewing the plot: Under ideal conditions (25C & 0 M NaCl) the titration 
endpoint occurs at ~1.65 ml HCl. At more realistic conditions (1m NaCl) the endpoint occurs at ~1.6 
ml HCl. This is a difference of ~3%.  
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Task 5: Effects of Temperature and Salinity on Acetate Alkalinity 

✓ Return to the Alkalinity-Bicarbonate-NaCl brine 

✓ Keep the 23000 mg/l Na+ and 35453 mg/l Cl-  

✓ Erase the HCO3-1 value and add 100 mg/l acetate-1, and then Calculate 

✓ Return to the Alkalinity Titrator and set the maximum HCl to 2 ml 

✓ Click on Auto Step  

✓ Recalculate to create the following pH vs. HCl plot  

 

Consider the following when viewing the plot: Under ideal conditions (25C & 0 M NaCl) the titration 
endpoint occurs at ~1.1 ml HCl. At more realistic conditions (1m NaCl) the endpoint occurs at 0.75 
ml HCl. A difference of ~32%! 

Summary 

The purpose of this chapter was to present the quantitative chemistry of alkalinity and to expose 
some additional calculation features within ScaleChem. From this, we can see that additional 
measurements for organic acids, bisulfides, and borates can be important when considering 
carbonate scale risks. 

Further Reading 

SPE 37277 – Alkalinity in Oilfield Waters. What alkalinity is and how it is measured. 1996. B. Kaasa 
and T Ostvold. 1997 SPE international symposium on Oilfield Chemistry. Houston TX. 

James Drever. 1988. The Geochemistry of Natural Waters, Chapter 4: The Carbonate System and 
pH control. Prentice Hall. 
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 –Calculating Alkalinity 

Overview 

In this chapter you will learn: 

• How to calculate acid:anion ratios at varying ionic strengths 

• Use the Mixing Water calculation as a pH titration apparatus 

• Understand how weak acid chemistry affects alkalinity 

• Compare true bicarbonate and carbonate concentrations to carbonate alkalinity 

 

Investigating the Components that Create Alkalinity 

The alkalinity measurement is used to compute carbonate scale tendencies and pH buffer capacity. 
Bicarbonate, and to a lesser degree, borates, organic acids and bisulfides, provide alkalinity to 
produced water. Therefore, this chapter is an introduction to quantifying alkalinity beyond the 
standard contributions from 𝐻𝐶𝑂3

−, 𝐶𝑂3
−2 and 𝑂𝐻−.  

 

Carbonate Alkalinity Contributions 

The Standard Methods for the Examination of Water and Wastewater codified the measurements to 
determine alkalinity. In its second edition (1912), the book linked alkalinity and total hardness to 
CaCO3 scale (an interesting side note, in the year of publication, olive oil-derived castile soap was 
used to measure total water hardness instead of inductively coupled plasma spectrometry). 
Measurements related to Lacmoid, Erythrosine, Methyl orange, silver nitrate and phenolphthalein, 
were all designed to measure carbonate and hydroxide alkalinity. The contribution of non-carbonate 
and non-hydroxide buffers, like organic acids, do not have supporting text. Oilfield water analyses 
continue to use the original experimental design with the same endpoint, despite the measurement 
does not capture the produced water species complexity. 

Alkalinity equations are a series of chemical reactions with measurable endpoints, described below: 

𝐻𝐶𝑂3
−2 + 𝐻+ = 𝐶𝑂2 + 𝐻2𝑂  𝑐𝑜𝑛𝑠𝑖𝑑𝑒𝑟𝑑 𝑐𝑜𝑚𝑝𝑙𝑒𝑡𝑒 𝑏𝑦 𝑝𝐻 < 4.5 (25°𝐶) 

𝐶𝑂3
−2 + 𝐻+ = 𝐻𝐶𝑂3

−  𝑐𝑜𝑛𝑠𝑖𝑑𝑒𝑟𝑑 𝑐𝑜𝑚𝑝𝑙𝑒𝑡𝑒 𝑏𝑦 𝑝𝐻 < 8.5 (25°𝐶) 

𝑂𝐻− + 𝐻+ = 𝐻2𝑂 𝑐𝑜𝑛𝑠𝑖𝑑𝑒𝑟𝑑 𝑐𝑜𝑚𝑝𝑙𝑒𝑡𝑒 𝑏𝑦 𝑝𝐻 < 10 (25°𝐶) 
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Thus, a simple definition for carbonate alkalinity is: 

𝐶𝑎𝑟𝑏𝑜𝑛𝑎𝑡𝑒 𝐴𝑙𝑘𝑎𝑙𝑖𝑛𝑖𝑡𝑦 = 𝑇𝑜𝑡𝑎𝑙 𝐻+𝑟𝑒𝑞𝑢𝑖𝑟𝑒𝑑 𝑡𝑜 𝑐𝑜𝑛𝑣𝑒𝑟𝑡 𝑎𝑙𝑙 𝐶𝑂3
−2, 𝐻𝐶𝑂3

−, 𝑎𝑛𝑑 𝑂𝐻−𝑡𝑜 𝐶𝑂2 

= 𝐻+ (𝑓𝑟𝑜𝑚 𝐶𝑂3
−2) + 𝐻+ (𝑓𝑟𝑜𝑚 𝐻𝐶𝑂3

− 𝑎𝑛𝑑 𝑛𝑒𝑢𝑡𝑟𝑎𝑙𝑖𝑧𝑒𝑑 𝐶𝑂3
−2) + 𝐻+ (𝑓𝑟𝑜𝑚 𝑂𝐻−)

= 𝑡𝑜𝑡𝑎𝑙 𝑎𝑐𝑖𝑑 𝑎𝑑𝑑𝑒𝑑 𝑡𝑜 𝑏𝑟𝑖𝑛𝑔 𝑡ℎ𝑒 𝑝𝐻 𝑡𝑜 < 4.5 

= 2𝐶𝑂3
−2 + 𝐻𝐶𝑂3

− + 𝑂𝐻− 

 

Lastly, a mass balance equation for carbonate: 

𝐶𝑎𝑟𝑏𝑜𝑛𝑎𝑡𝑒𝑇𝑜𝑡𝑎𝑙 = 𝐻𝐶𝑂3
− + 𝐶𝑂3

−2 

 

A Bjerrum plot, in which carbonate concentration is fixed, shows the relative concentration of each 
species as functions of pH (also shown is the relative OH- concentration): 

 

The calculations provide measurable hydroxide, carbonate and bicarbonate concentrations at a 
relative pH: free hydroxide (OH-) exists above 10 pH; carbonate exists above 8.5 pH; and 
bicarbonate exists between 4.5 and 8.5 pH. 

An alkalinity titration procedure is as follows:  

1. Start with a known sample volume 

2. Add two indicators - the first activates at 8.5 pH or higher and the second is active below 4.5 pH 

3. Titrate the sample with a strong acid of known composition  
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When the first indicator deactivates (the pH drops below 8.5), the amount of titrant added is the 
carbonate alkalinity and hydroxide alkalinity point. The following equation converts the acid volume 
to the carbonate alkalinity. 

𝐶𝑂3
− 𝐴𝑙𝑘 (

𝑚𝑔

𝐿
)  𝑎𝑠 𝐻𝐶𝑂3

−

= 𝐴𝑐𝑖𝑑 𝑣𝑜𝑙𝑢𝑚𝑒 𝑢𝑠𝑒𝑑 𝑡𝑜 8.5 𝑝𝐻 (𝐿) × 𝐴𝑐𝑖𝑑 𝐶𝑜𝑛𝑐. (
𝑚𝑜𝑙𝑒𝑠

𝐿
) × 61020 (

𝑚𝑔 𝐻𝐶𝑂3
−

𝑚𝑜𝑙𝑒
)

×
1

𝑆𝑎𝑚𝑝𝑙𝑒 𝑉𝑜𝑙 (𝐿)
 

 

4. The sample is titrated further until it until the second indicator appears (pH<4.5).  This is the 
bicarbonate alkalinity endpoint. This information is used as follows: 

𝐻𝐶𝑂3
− 𝐴𝑙𝑘 (

𝑚𝑔

𝐿
)  𝑎𝑠 𝐻𝐶𝑂3

−

=  𝑉𝑜𝑙 𝐴𝑐𝑖𝑑 𝑓𝑜𝑟 𝐵𝑖𝑐𝑎𝑟𝑏𝑜𝑛𝑎𝑡𝑒 𝐴𝑙𝑘 𝑇𝑖𝑡𝑟𝑎𝑡𝑖𝑜𝑛 (𝐿) × 𝐴𝑐𝑖𝑑 𝐶𝑜𝑛𝑐. (
𝑚𝑜𝑙𝑒𝑠

𝐿
)

× 61020 (
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙𝑒
) ×

1

𝑆𝑎𝑚𝑝𝑙𝑒 𝑉𝑜𝑙 (𝐿)
 

 

The two titrations combine to calculate the total alkalinity 

𝑇𝑜𝑡𝑎𝑙 𝐴𝑙𝑘 (
𝑚𝑔

𝐿
)  𝑎𝑠 𝐻𝐶𝑂3

−

= 𝑉𝑜𝑙 𝐴𝑐𝑖𝑑 𝑓𝑜𝑟 𝐶𝑎𝑟𝑏𝑜𝑛𝑎𝑡𝑒 𝐴𝑙𝑘 𝑇𝑖𝑡𝑟𝑎𝑡𝑖𝑜𝑛 (𝐿)

+  𝑉𝑜𝑙 𝐴𝑐𝑖𝑑 𝑓𝑜𝑟 𝐵𝑖𝑎𝑟𝑏𝑜𝑛𝑎𝑡𝑒 𝐴𝑙𝑘 𝑇𝑖𝑡𝑟𝑎𝑡𝑖𝑜𝑛 (𝐿) × 𝐴𝑐𝑖𝑑 𝐶𝑜𝑛𝑐. (
𝑚𝑜𝑙𝑒𝑠

𝐿
)

× 61020 (
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙𝑒
) ×

1

𝑆𝑎𝑚𝑝𝑙𝑒 𝑉𝑜𝑙 (L)
 

 

𝑂𝐻−𝐴𝑙𝑘 (
𝑚𝑔

𝐿
)  𝑎𝑠 𝐻𝐶𝑂3

− = 𝐶𝑂3
− 𝐴𝑙𝑘 (

𝑚𝑔

𝐿
) − 𝐻𝐶𝑂3

− 𝐴𝑙𝑘 (
𝑚𝑔

𝐿
) 

 

5. In the absence of carbonates or in addition to carbonate, the OH- alkalinity can also be 
determined from the difference between the carbonate and bicarbonate alkalinity and is only 
relevant above 9.5 or 10pH (OH->10-4.5 M or ~0.5ppm).  

𝐴𝑙𝑘𝑂𝐻 = 2 ∗ 𝐴𝑙𝑘8.5𝑝𝐻 𝐸𝑃 − 𝐴𝑙𝑘4.5𝑝𝐻 𝐸𝑃 

If the value is negative, then there is no hydroxide alkalinity.  Hydroxide alkalinity is not common in 
production waters because the pH is never that high. It is present in drilling and alkaline injection 
fluids.  
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Problem Statement  

Oilfield waters do not conform chemically, to the fresh water used in the original alkalinity method. 
Organic acids, borates, phosphates, sulfides and other proton-accepting species produce alkalinity. 
Consequently, the standard alkalinity titration cannot be used to measure the bicarbonate/carbonate 
concentration. We will evaluate this in the following examples.  

Task 1: Quantifying Alkalinity of Certain Anions 

You will compute the alkalinity of 100 mg/L of the following anions: HCO3
-, CO3

-2, OH-, CH3CO2
-, 

B(OH)4
-, SO4

-2, Cl- and HS. The counter-ion will be sodium making the system basic. There will be 
no additional salt (salinity) added the first set of calculations. This will allow you to quantify alkalinity 
at near-ideal activities. You will calculate a second time in the presence of 1M NaCl. You will 
conclude this section by producing a quantitative table showing the contribution to alkalinity as a 
function of species and salinity.  

We will be using C and atm units for Temperature and Pressure so please adjust accordingly.  

✓ Create a new file called “Alkalinity”  

✓ Add a new brine analysis  

✓ Rename it Alkalinity 

 

Bicarbonate 

✓ Select the Design tab  

✓ Find HCO3-1 in the Anions grid and give it a value of 100 mg/L 

✓ Check the Non-zero only box 

 

 

 

✓ Select the Reconcile tab 

✓ Leave the default reconciliation option (Concentration Data Only) 

✓ Click calculate and document the pH and alkalinity 
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The calculated pH is 8.27. The calculated alkalinity is 100.7 mg/L and is entirely the bicarbonate 
alkalinity. The 0.7 mg/L addition to the alkalinity value is due to the pH endpoint and minor activity 
coefficient effects.  

The next three steps will make it easier for us to perform titrations later. Alternatively, we can continue 
working in the same Alkalinity file and replace the anions as we go along. Subsequent instructions 
will be applicable for both approaches.  

✓ In the Navigator pane, right-mouse click Alkalinity and press copy 

  

✓ Right-mouse click the Streams icon, then select paste. Repeat this 7 times, to create a total of 8 
objects in the navigator panel. 

 

The software designates the new streams as Alkalinity -1, Alkalinity-2, and so on.  

✓ Rename the objects so that the anion they contain will be easily identifiable: Alkalinity-
Bicarbonate, Alkalinity-Carbonate, Alkalinity-Hydroxide, Alkalinity-Acetate, Alkalinity-Borate, 
Alkalinity-Sulfate, Alkalinity-Chloride, and Alkalinity-Bisulfide  
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Carbonate 

✓ Select the Alkalinity-Carbonate brine analysis stream  

✓ Remove the 100 mg/L HCO3-1 and add 100 mg/L CO3-2  

✓ Check the Non-zero only box 

 

 

 You can either type in CO3-2 in an empty cell, or select the Expanded Template to locate it in 
the Anion grid.  

✓ Select the Reconcile tab and recalculate  

 

The alkalinity is 204.1 mg/L as 𝐻𝐶𝑂3
− twice the 𝐶𝑂3

−2 concentration added, and is consistent with the 

above equation. The 𝐻𝐶𝑂3
− formula weight is 61.02 g/mole and 𝐶𝑂3

−2 is 60.01 g/mole – a mole ratio 

of 1.7%. Two factors contribute to the alkalinity increase. The first is that 𝐶𝑂3
−2 accepts two 𝐻+ ions 

one above 8.5 pH and one above 4.5 pH. The second is that 1.7% additional moles of carbonate are 
added because of the weight difference. Thus, the theoretical alkalinity of 100 mg/L alkalinity as 
𝐻𝐶𝑂3

− *2 * 1.7% = 203.4 mg/L alkalinity as 𝐻𝐶𝑂3
−. The computed value is 204.1. 

Note the slight bias forming in the results. Instead of exactly 203.4 mg/L, the value is 0.70 mg/L 
higher. This difference is due to non-ideal effects and the precise pH choice. The equations provided 
above are for ideal conditions. However, we are well aware that there are non-ideal effects that must 
be considered.  
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Hydroxide 

✓ Select the Alkalinity-Hydroxide brine analysis stream  

✓ Remove the 100 mg/L HCO3-1 and add 100 mg/L OH-  

 

✓ Select the Reconcile tab and recalculate  

 

The computed alkalinity is 361.3 mg/L as HCO3
-1. The formula weight of 𝑂𝐻− is 17.01 g/mole 

compared with 61.02 g/mole for 𝐻𝐶𝑂3
−1, so 3.587 times more moles of 𝑂𝐻− is added compared with 

𝐻𝐶𝑂3
−.  

Therefore, 

61020

17010
× 100

𝑚𝑔 𝑎𝑠 𝐻𝐶𝑂3
−

𝐿
= 358.7

𝑚𝑔 𝑎𝑠 𝐻𝐶𝑂3
−

𝐿
 

Complete 𝑂𝐻− neutralization actually happens at about 10 pH, not 4.5 pH, which is the experimental 
endpoint. Observing the neutralization effect requires a titration curve.  
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Task 2: Non-Carbonate Alkalinity Contributions 

We will see complications arising when other species contribute to alkalinity because they affect the 
direct use of the alkalinity value in the carbonate/scale tendency equation. Contributing species 
include borate, phosphate, formate, acetate, propanate, bisulfide, and any anion that will accept H+ 
ion above 4.5 pH.  

 

Acetate 

✓ Select the Alkalinity-Acetate brine analysis stream  

✓ Zero out any existing concentrations and add 100 mg/L acetate C2H3O2-1 

 

✓ Select the Reconcile tab and recalculate  

 

The computed alkalinity is 68.9 
𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

−. The acetate formula weight is 59.05 g/mole, close to 

𝐻𝐶𝑂3
− (61.02 g/mole). So, if all the acetate contributes to alkalinity, then 100 mg/L acetate should be 

close to that for 100 mg/L 𝐻𝐶𝑂3
− as shown in the following equation:  

61020 
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙

59050 
𝑚𝑔 𝐴𝑐𝑒𝑡𝑎𝑡𝑒−

𝑚𝑜𝑙

× 100
𝑚𝑔 𝐴𝑐𝑒𝑡𝑎𝑡𝑒−

𝐿
= 103.3

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− 

The theoretical alkalinity contributed by acetate is 103.3 
𝑚𝑔

𝑙
𝑎𝑠 𝐻𝐶𝑂3

−. This means that 68.95
103.3⁄ =

67% of the acetate ion accepted an 𝐻+ at 4.5 pH (33% remained as the 𝐶2𝐻3𝑂2
− ion). Acetate 

concentrations therefore have significant impact on total alkalinity.  

 

Borate 

✓ Select the Alkalinity-Borate brine analysis stream 

✓ Remove any existing concentrations and add 100 mg/L borate, B(OH)4-1 
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✓ Select the Reconcile tab and recalculate  

 

The borate contribution is 79.52 
𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− for 100 mg/L added. If 100% borate contributed to 

alkalinity the maximum value would be: 

61020 
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙

78835 
𝑚𝑔 𝐵(𝑂𝐻)4

−

𝑚𝑜𝑙

× 100
𝑚𝑔 𝐵(𝑂𝐻)4

−

𝐿
= 77.39

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− 

The theoretical alkalinity is slightly lower than the computed amount (we will investigate this next). 
Thus, borate appears to be significant contributor to alkalinity. However, the pH is high, 10.12. Borate 
is generally neutralized to boric acid by ~7 pH. Consequently, only a fraction of the total boron in 
produced water is in anion form. Most is found in the acidic form 𝐻3𝐵𝑂3. 

 

Sulfate 

✓ Select the Alkalinity-Sulfate brine analysis stream  

✓ Remove any existing concentrations and add 100 mg/L sulfate (SO4
−2)  

 

✓ Select the Reconcile tab and recalculate  

 



OLI Studio: ScaleChem Basics –Calculating Alkalinity  12-10 

The sulfate contribution is 2.2 mg/L as HCO3
- for 100 mg/L SO4

-2 added. If 100% sulfate contributed 
to alkalinity the maximum value would be: 

61020 
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙

96060 
𝑚𝑔 𝑆𝑂4

−2

𝑚𝑜𝑙

× 100
𝑚𝑔 𝑆𝑂4

−2

𝐿
= 63.52

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− 

Sulfate has negligible effects on alkalinity. This is not surprising, since 𝑆𝑂4
−2 is a salt of an acidic 

anion 𝐻𝑆𝑂4
−. To reach the theoretical contribution of 63.52 

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

−, the endpoint pH would be 

near 0.3. 

 

Chloride 

✓ Select the Alkalinity-Chloride brine analysis stream 

✓ Remove any existing concentration and add 100 mg/L chloride (Cl-)  

 

✓ Select the Reconcile tab and recalculate  

 

The chloride contribution is 2.04 mg/L as bicarbonate for 100 mg/L Cl- added. If 100% chloride 
contributed to alkalinity the maximum value would be: 

61020 
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙

35453 
𝑚𝑔 𝐶𝑙−

𝑚𝑜𝑙

× 100
𝑚𝑔 𝐶𝑙−

𝐿
= 172.1

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− 

Chloride has negligible effects on alkalinity for the same reason as sulfate. Both are conjugate bases 

of strong acids. To reach the theoretical contribution of 172.1 
𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

−, the endpoint pH would be 

about 5. 

 

Bisulfide 

✓ Select the Alkalinity-Bisulfide brine analysis stream 

✓ Remove any existing concentration and add 100 mg/L bisulfide (HS−)  
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✓ Select the Reconcile tab and recalculate  

 

The calculated bisulfide contribution is 186.13 
𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− for 100 mg/L added. If 100% sulfate 

contributed to alkalinity the maximum value would be: 

61020 
𝑚𝑔 𝐻𝐶𝑂3

−

𝑚𝑜𝑙

33070 
𝑚𝑔 𝐻𝑆−

𝑚𝑜𝑙

× 100
𝑚𝑔 𝐻𝑆−

𝐿
= 184.5

𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

− 

The theoretical bisulfide ion alkalinity is 184.5 
𝑚𝑔

𝐿
𝑎𝑠 𝐻𝐶𝑂3

−. It has a significant impact on alkalinity. 

Bisulfide concentrations however are generally low in produced water. Therefore, the absolute 
effects are small. 

A summary of all the calculation results are shown in the table below. 

100 mg/L of the following ion Initial pH Alkalinity as mg/L HCO3 

HCO3- 8.27 100.66 

CO3-2 10.64 204.1 

OH- 11.73 361.29 

Acetate- 7.99 68.89 

B(OH)4- 10.13 79.52 

SO4-2 7.01 2.21 

Cl- 6.99 2.04 

HS- 9.19 186.13 
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Task 3: Alkalinity Titration Curves  

The alkalinity endpoint provides a snapshot of fluid chemistry. A complete titration curve shows the 
system behavior across the pH profile and therefore the buffering region of different bases. In this 
section, we will create alkalinity titration curves for 100 mg/L of HCO3

-, CO3
-2, OH-, Acetate-, and 

B(OH)4
-. 

The first two sections below are alternatives. Clients can either use OLI Studio: ScaleChem objects 
to create the 1N HCL reagent or use the OLI Studio: Stream Analyzer module.  

 

Task 3-1 Create the 1N HCl Reagent with OLI Studio: ScaleChem 

✓ Add a new brine analysis  

✓ Name it 1N HCl-1 

✓ Type HCL in the neutrals section with 36,453 mg/L 

✓ Select the show non-zero box  

 

✓ Select the Reconcile tab then calculate  

 

It should not be surprising that the reagent pH is almost zero. HCl is a strong acid, and thus the H-
Cl bond is weak, resulting in near complete dissociation. Thus, there is 1 mole H+ in solution or zero 
pH. 

✓ Save the file 

 

Task 3-2 Create the 1N HCl Reagent with OLI Studio: Stream Analyzer  

✓ Select the Global Streams icon in the Navigator pane  

 

✓ Double-click the Add Stream icon in the Actions pane  
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✓ Press the <F2> key and change the name to 1N HCl-2 

✓ Select the Units Manager icon then use the Quicklist button to pick Metric, concentration 

 

✓ Press OK then enter HCl as an inflow with a concentration 36,453 mg/L 

 

Task 3-3 Create an Alkalinity Titration 

Once we complete either of the above methods for creating the HCl reagent stream, we can proceed 
with the following tasks.  

✓ Add a Mixing Water object    

✓ Rename it Alkalinity Titrator 

✓ Change the Brine Volumes to ml (per day) by clicking a blue-colored unit and opening the Units 
Manager 

    

✓ Select the bottom right corner of the Name cell and pick 1N HCL-1 as the first brine  

 

Note: Remember that first brine is the stream that the Mixer will adjust. 

 

✓ Set the total volume to 1000 mL/day 

 

The 1L volume is the total liquid volume (sum of 1st and 2nd brine). In this case, the 1L will be primarily 
the alkalinity liquid that we will enter next. The 1N HCl reagent will be added to the Alkalinity liquid, 
but its volume will be relatively small. It is an imperfect example, but it serves to show another 
application of the Mixing tool. The actual flow rate is unimportant, but for realism, we will use a 
volume similar to laboratory conditions.  
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Task 3-4 Bicarbonate Titration Curve 

✓ Select the bottom right corner of the Name cell in the Second Brine row and pick the Alkalinity-
Bicarbonate (the original Alkalinity brine) as the second brine 

 

✓ Go to the Conditions tab 

✓ Change the type from Ratio to Flow 

 

✓ Type 2 in the first column and first row then press tab and type 0 in the second row   

 

✓ Change the Auto Steps amount to 20 then select the Auto Step button  

 

The software will add the HCl at 0.1 mL increments up to 2 mL. It will also remove 0.1 mL of Alkalinity-
HCO3 volume at each step to maintain the 1000 mL volume. Consequently, the titration we are doing 
is not 100% correct. In an actual titration, the sample fluid volume is fixed at 100 mL. Fortunately, 
the HCl reagent is concentrated, and the volume added is small. This limits the displacement error 
to 0.2%  
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✓ Press the Calculate button  

✓ Select the Plot tab and then select the Variables button  

✓ Remove all existing plot variables in the Y1 Axis by highlight the Y1 axis header then select the 
<< arrow button  

 

✓ Expand the Aqueous category and add HCO3-1 to the Y1 axis  

✓ Expand the Additional Stream Parameters category and add pH-Aqueous to the Y2 axis  

 

✓ Press OK and view the plot 

 

The pH curve is the typical bicarbonate-buffering curve. The slope of the curve is shallow between 
pH 7 and 5.5, where bicarbonate buffering is strong. Below 5.5 pH, the curve drops sharply and has 
its steepest slope at about 4.5 pH. 
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✓ Click the View Data button 

  

✓ Copy the data to a spreadsheet program by holding down the left arrow, highlighting all the points 
and pressing <Ctrl+C>. 

✓ Click on the View Plot button to show the plot again  

 

For the following titrations, we can either add a new Mixing Water object or work from the existing 
object. The instructions below assume the latter.  

 

Task 3-5 Carbonate Titration Curve 

✓ Return to the Design | Inlets screen 

✓ Replace the second brine with the Alkalinity – Carbonate stream  

 

✓ Select the Conditions tab and change the 1N HCl flow from 2 ml to 4 ml (top cell) 

 

We will need twice as much acid to titrate the CO3
-2 
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✓ Make sure Auto steps are set at 20 and click on the Auto Step button then click on the calculate 
button 

 

✓ Select the Plot tab then select the Variables button 

✓ Add CO3-2 from the Aqueous categories to the Y1 Axis  

 

✓ Press OK and view the Plot 

 

✓ Click on the View Data button then copy data to a spreadsheet program 

✓ Click on the View Plot button to show the plot again  

✓ Save the file   
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Task 3-6 Hydroxide Titration Curve 

✓ Return to the Design | Inlets tabs and replace the Carbonate stream with Hydroxide  

 

✓ Select the Conditions, tab then overwrite the first cell with 7 ml  

✓ Press the Auto Step button and then click the calculate button 

 

✓ Select the Plot tab then select the Variables button 

✓ Remove the carbonates by double clicking on them 

✓ Add OH- from the Aqueous section to the Y1 axis, and add pH in the Y2 axis 

 

✓ Select the View Data button and copy the data to a spreadsheet 

✓ Click on the View Plot button to show the plot again  

✓ Save the file   
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Task 3-7 Acetate Titration Curve 

✓ Repeat the same procedure for Acetate 

 

✓ Select the Conditions, tab then overwrite the first cell with 2 ml  

✓ Reset the Auto Steps to 20 

✓ Press calculate then plot pH on the Y2 Axis and acetate ion (C2H3O2-1)to the Y1 axis  

 

✓ Save the file  

✓ Click on the View Data button then copy the data to a spreadsheet program 
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Task 3-8 Borate Titration Curve 

✓ Redo the calculation for Borates 

✓ Decide upon which species are important to plot 

 

✓ Click on the View Data button and copy data to a spreadsheet program 

✓ Save the file   
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Task 3-9 Sulfate Titration Curve 

✓ Repeat for Sulfate 

 

The sulfate titration calculation was taken well beyond the alkalinity endpoint in order to show the 
equilibrium between the SO4

-2 and HSO4
- species. At ~2 pH, SO4

-2 and HSO4
-have roughly the same 

concentration: this is a sulfate buffering region.  

✓ Click on the View Data button and copy the data to a spreadsheet program 

✓ Save the file   
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Task 3-10 Interpreting the Titration Data 

✓ Move to the spreadsheet  

✓ Plot the pH vs. HCl  

 

This plot shows the buffering (pH) regions and the total buffering capacity of each weak acid. The 
highest buffering capacity, though not relevant to produced waters, is OH-. It’s relatively low 
molecular weight (17 g/mol) results in more buffering per concentration (all are fixed at 100 mg/l). Its 
buffering region ends at about 10.5 pH (extent of shallow slope). At this pH virtually all the OH is 
consumed by the HCl titrant. Consequently, at typical produced water pH (between 5 and 8) no OH- 
buffering occurs.   
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✓ Plot the species concentrations vs. pH 

 

The plot above shows the concentration impact in greater detail. It represents the concentration of 
free ion vs. pH for the different buffers. The red vertical line to the far left is the pH titration end point. 
The shaded vertical section to the right is the typical produced water pH as measured in the 
laboratory. From this diagram we can see that very little OH- exists in produced water between 7 and 
8 pH. 

The carbonate ion is dibasic (accepts two H+) and therefore has two buffering regions and endpoints. 
The first buffering zone exists from 10.7 to 9 pH, and the sharp pH drop reflects CO3

-2 depletion from 
solution. Few produced waters have pH above 8, and therefore CO3

-2 alkalinity is rarely observed. 
The second buffering region of CO3

-2 is associated with protonating HCO3
-, and this second zone 

parallels exactly the 100 m/l HCO3
-1 titration curve. This second curve is the main alkalinity 

component in produced waters. Its existence is due to the continuous production of CaCO3(s) in 
seawater. 

The acetate buffering zone is between about 5.7 and 3.5 (end of curve). If the titration were extended, 
then the inflection point ~2.7 pH would have been observed. This buffering zone straddles the 
alkalinity endpoint, which is why it creates complications when measuring total alkalinity without an 
organic acid content. Organic acids are products of organics/kerogen catagenesis, which creates 
the fossil fuel. Therefore, it is commonly observed in produced waters. Lastly, the borates buffering 
region is between 10 and 8 pH with an end point at about 6 pH. Borates exist at pH’s higher than the 
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typical produced water, but when borate concentrations are high and the laboratory measured pH 
approaches or exceeds 8, then this base will affect total alkalinity. Borates exist in seawater and 
deposit in the interstices of sediments. They are also fairly soluble (like Cl and Na) and are generally 
found in produced waters.  

The table below contains the pH and concentration data from the calculations we ran and plotted 
above. The shaded cells represent the regions in the titration curves that would contribute to a 
produced water alkalinity. At the bottom of the table is a % range value. This value represents the 
fraction of the species concentration that would contribute to the alkalinity. 

HCO3-1 CO3-2 OH- Acetate-1 BOH4-1 SO4-2 HS- 

pH mg/l pH mg/l pH mg/l pH mg/l pH mg/l pH mg/l pH mg/l 

3.5 0 3.2 0 2.8 0 3.4 4 3.2 0 2.8 87 3.0 0 

3.6 0 3.3 0 2.9 0 3.5 6 3.2 0 2.8 88 3.1 0 

3.8 0 3.6 0 3.1 0 3.7 7 3.3 0 2.8 88 3.3 0 

4.1 1 4.1 0 3.3 0 3.8 10 3.4 0 2.8 89 3.4 0 

4.8 3 5.2 0 3.8 0 3.9 13 3.5 0 2.9 89 3.8 0 

5.3 9 5.7 0 10.3 4 4.1 17 3.7 0 2.9 90 4.9 1 

5.6 15 6.0 0 10.7 10 4.2 21 3.9 0 2.9 90 5.9 7 

5.7 21 6.2 0 11.0 17 4.3 26 4.5 0 2.9 91 6.2 14 

5.9 27 6.4 0 11.1 23 4.4 31 8.0 5 3.0 91 6.4 20 

6.0 33 6.6 0 11.2 29 4.5 37 8.4 13 3.0 92 6.5 27 

6.1 39 6.9 0 11.3 36 4.6 42 8.6 21 3.1 92 6.7 34 

6.2 45 7.4 0 11.4 42 4.7 48 8.8 28 3.1 93 6.8 40 

6.3 51 8.8 4 11.4 49 4.8 54 9.0 36 3.2 94 6.9 47 

6.4 57 9.5 14 11.5 55 4.9 59 9.1 44 3.2 94 7.0 54 

6.6 63 9.7 24 11.5 62 5.0 65 9.2 51 3.3 95 7.1 60 

6.7 69 10.0 34 11.6 68 5.2 71 9.4 58 3.4 95 7.3 67 

6.8 75 10.1 43 11.6 74 5.3 77 9.5 66 3.5 96 7.4 73 

7.0 81 10.3 51 11.6 81 5.4 82 9.6 73 3.6 97 7.6 80 

7.2 87 10.4 59 11.7 87 5.6 88 9.8 79 3.8 97 7.8 87 

7.5 93 10.5 66 11.7 94 6.0 94 10.0 84 4.1 98 8.1 93 

8.3 98 10.6 71 11.7 100 8.0 100 10.1 89 7.0 99 9.2 99 
              

% in range 93  0  0  63  5  1  79 

Consider the following with this table: Anions are now being measured using ion chromatography. 
How does the alkalinity value measured relate to this ion chromatography measured ions?  
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Task 4: Effects of Temperature and Salinity on Carbonate Alkalinity 

✓ Return to the original Alkalinity (or Alkalinity-Bicarbonate) brine 

✓ Copy and paste it to create a new one 

✓ Rename it Alkalinity-Bicarbonate-NaCl 

✓ Add 23000 mg/l Na+ and 35453 mg/l Cl- 

 

✓ Return to the Alkalinity Titrator object and select the Inlets tab 

✓ Change the second brine to the new Alkalinity-Bicarbonate-NaCl brine 

✓ Set the Max HCl to 2ml and press the Auto Steps 

✓ Calculate, Select the Plot tab, then the Variables button  

✓ Remove all the variables from the Y1 and Y2 axes 

✓ Add HCO3
- from the Aqueous category to the Y1 Axis and pH from the Additional Stream 

Parameters section in the Y2 Axis  

 

✓ Copy the data to the Spreadsheet and add this plot with the original HCO3
- titration plot  

✓ Click on the Alkalinity Titration’s Inlets tab and change the temperature to 75C  

✓ Calculate 
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✓ Plot the pH vs. HCl for the three 100 mg/l HCO3
- calculations (25C, 25C & 1N NaCl, and 75C & 

1N NaCl). 

 

Consider the following when viewing the plot: Under ideal conditions (25C & 0 M NaCl) the titration 
endpoint occurs at ~1.65 ml HCl. At more realistic conditions (1m NaCl) the endpoint occurs at ~1.6 
ml HCl. This is a difference of ~3%.  
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Task 5: Effects of Temperature and Salinity on Acetate Alkalinity 

✓ Return to the Alkalinity-Bicarbonate-NaCl brine 

✓ Keep the 23000 mg/l Na+ and 35453 mg/l Cl-  

✓ Erase the HCO3-1 value and add 100 mg/l acetate-1, and then Calculate 

✓ Return to the Alkalinity Titrator and set the maximum HCl to 2 ml 

✓ Click on Auto Step  

✓ Recalculate to create the following pH vs. HCl plot  

 

Consider the following when viewing the plot: Under ideal conditions (25C & 0 M NaCl) the titration 
endpoint occurs at ~1.1 ml HCl. At more realistic conditions (1m NaCl) the endpoint occurs at 0.75 
ml HCl. A difference of ~32%! 

Summary 

The purpose of this chapter was to present the quantitative chemistry of alkalinity and to expose 
some additional calculation features within ScaleChem. From this, we can see that additional 
measurements for organic acids, bisulfides, and borates can be important when considering 
carbonate scale risks. 

Further Reading 

SPE 37277 – Alkalinity in Oilfield Waters. What alkalinity is and how it is measured. 1996. B. Kaasa 
and T Ostvold. 1997 SPE international symposium on Oilfield Chemistry. Houston TX. 

James Drever. 1988. The Geochemistry of Natural Waters, Chapter 4: The Carbonate System and 
pH control. Prentice Hall. 
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